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Preface

About this User’s Guide

This guide describes the recommended procedures for the installation, configuration, 
troubleshooting, and support of OpenSpirit. This covers OpenSpirit runtime use. This guide 
also presents a tutorial in the use of the OpenSpirit runtime utilities and viewers.

Material in this guide pertains to the OpenSpirit version specified on the Cover page of this 
document and is included on the OpenSpirit CD or downloaded image and installed in the 
top level directory of every OpenSpirit installation.

Intended Audience

The Getting Started and Tutorial sections should be of interest to end users of OpenSpirit 
enabled applications, developers of OpenSpirit enabled applications, and administration 
and support staff involved with supporting OpenSpirit.

The Installation, Configuration, Support and Troubleshooting sections will mainly be of 
interest to administration and support staff involved with supporting OpenSpirit.

Additional Sources of Information

An extensive Developer's Guide, including data model summaries, architectural overview, 
reference documentation, and sample applications is included in the OpenSpirit developer 
packages. The developer packages can be found online at the OpenSpirit Developer Forum 
web site, devnet.openspirit.com. 

http://devnet.openspirit.com
http://devnet.openspirit.com
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Contacting OpenSpirit Corporation

For general information on our products and services please contact us at:

OpenSpirit Corporation

4800 Sugar Grove Blvd.

Suite 500

Stafford, TX 77477

Phone +1 281 295-1400

FAX    +1 281 295-1401

Email: info@openspirit.com

Web: www.openspirit.com

For support or other technical assistance

Email: support@openspirit.com or call 281 295-1400 and ask for support.

Web based support information: www.openspirit.com/support

http://www.openspirit.com
http://www.openspirit.com/support
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1   Introduction

hrough OpenSpirit's Application Integration Framework, you'll see new opportunities made possible. 
OpenSpirit will give you the ability to bring together the tools you already use in ways that were never 
before possible. OpenSpirit works with applications from multiple sources that are able to run on the 

most appropriate platforms, already integrated with the applications you use today. All this is made possible 
through the OpenSpirit Framework - a better way to work!

To take advantage of this framework, there are a few key elements that you need to learn about OpenSpirit 
and how it works. Chapter 2 of this guide contains a Basic Tutorial that will familiarize you with the most 
common runtime features.

If you run into problems, refer to the Support and Troubleshooting Guide that contains information on 
common problems and their solutions. If you can't solve your problem and need to contact someone 
immediately, see the Contact OpenSpirit Corporation page at the beginning of this document.

If you are a developer, visit the OpenSpirit Developer’s Forum at devnet.openspirit.com that will show you 
how to utilize the OpenSpirit toolkit for developing OpenSpirit applications. 

For additional information on OpenSpirit Corporation, future product plans, and additional services, visit our 
web site at www.openspirit.com. Thank you for choosing to learn more about OpenSpirit!

T

http://www.openspirit.com
http://www.openspirit.com
http://devnet.openspirit.com
http://devnet.openspirit.com
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Integration Framework

A basic OpenSpirit installation consists of the OpenSpirit Runtime plus one or more data connections and 
optional utilities. 

OpenSpirit Runtime 

The OpenSpirit Runtime consists of the following components:

• Base Framework - includes basic shared services required for any OpenSpirit application or data connection

• Launcher - allows you to create and edit OpenSpirit sessions and to launch OpenSpirit viewers and utilities

• DataSelector - a universal data selector that may be used to find data by attribute value from any project connected 
via OpenSpirit

• Well Viewer - view well log and well picks in a multi-track view

• Section Viewer - view 2D or 3D seismic sections with intersecting horizon and fault data

• 3D Viewer - view wellbore paths, picks, logs, horizons and horizon properties, faults, drilling targets, and 2D and 
3D seismic data

Chapter 2 describes the use of these tools in more detail. 
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OpenSpirit Data Connections (Data Modules)

In order to allow OpenSpirit enabled utilities and third party applications to access your data, you'll need the 
appropriate OpenSpirit data connection.   Each data connection type is separately licensed and the current 
OpenSpirit version supports the following data access functionality:

F = full support (create, read, update and delete)

RO = read only

OW/SW GF
IESX/CH

EPOS Finder Kingdom Petra PPDM SEGY Recall ArcSDE

Well F F RO F F F RO F1

Well Bore F F RO F F F RO F

Well Bore List F F RO F RO RO2 F

Well Log F F RO F F F RO F

Well Pick F F RO F F F RO RO

Well Velocity F F RO F F

Well Attribute F

Well Bore 
Attribute F

Well Log Trace 
Attribute F

Logging Pass F

3D Survey F F F F

3D Dataset F F F F

2D Survey F F F F

2D Line F F F F

2D Dataset F F F F

Horizon Grid 2D 
(3D seismic)

F F F

Horizon Grid 2D 
(non seismic) F F F

Horizon Fault 
Boundaries F

Horizon PointSet RO
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** - Linux only
1 - Recall Wellbore does not support deviation surveys
2 - Synthesized from fields

Note: Please refer to our web site to learn of new or enhanced data connectors.

OpenSpirit Optional Utilities

OpenSpirit optional utilities include:

• Scan Utility - scans all your OpenSpirit enabled data stores to create and keep up to date shape files or ArcSDE 
layers that may be used in GIS systems

• ArcMap extension - allows ArcMap to be used as an OpenSpirit enabled data selector for well, seismic, and 
horizon data

• Excel Adapter - receive OpenSpirit data selection events and paste desired well, seismic, interpretation and SDE 
culture attributes into Excel

• Copy Manager- perform a one-step data transfer or well, seismic, and interpretation between OpenSpirit enabled 
data stores

The use of these utilities require a separate license feature to be purchased and are described in more detail in 
Chapter 2 of this User Guide.

Horizon Grid 1D 
(2D Seismic)

F F F

Fault Polyline Set 
(3D) F F F

Fault Polyline Set 
(2D) F F F

Fault PointSet RO

Culture
Point Feature RO

Culture
Polyline Feature RO

Culture
Polygon Feature

RO

OW/SW GF
IESX/CH

EPOS Finder Kingdom Petra PPDM SEGY Recall ArcSDE
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Below is a matrix of what OpenSpirit data types are supported by the various OpenSpirit tools and utilities:

Copy 
Manager

Data 
Selector

Scan Utility Excel 
Adapter

ArcMap 
Extension

3D Viewer Well Viewer Section 
Viewer

Well x x x x

Well Bore x x x x x x

Well Bore List x x

Well Log x x x x x

Well Pick x x x x x x

Well Velocity x x x

Logging Pass x x

3D Survey x x x x x

3D Dataset x x x x x x x

2D Survey x x x x

2D Line x x x x x

2D Dataset x x x x x x x

Horizon Grid 2D 
(3D seismic)

x x x x x x x

Horizon Grid 2D 
(non seismic) x x x x x x

Horizon Fault 
Boundaries x x x x

Horizon PointSet x x x x

Horizon Grid 1D 
(2D Seismic) x x x x x x

Fault Polyline Set 
(3D) x x x x x x

Fault Polyline Set 
(2D)

x x x x x x

Fault PointSet x x x x

Culture
Point Feature x x x x

Culture
Polyline Feature

x x x x

Culture
Polygon Feature x x x x
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Licensing 

All OpenSpirit products (the Runtime, the Data Connections, and Optional Utilities) are controlled by 
FLEXlm feature keys and are licensed on a per concurrent user session basis, independent of operating 
system. This means, for example, that a user may be using a Well Viewer running on Windows concurrently 
with a 3D Viewer running on Solaris where both are accessing data from one or more data connectors. In this 
case only one OpenSpirit Runtime and one data connector license per data connector type will be checked out. 

Please refer to the OpenSpirit web site (www.openspirit.com) for up-to-date information and details of 
supported platforms and operating system versions.

http://www.openspirit.com
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his chapter shows you how to begin using OpenSpirit in a runtime environment. 
OpenSpirit must be installed, configured, and running before starting this tutorial.

The tutorial will show you how to use the various OpenSpirit tools so that you can take 
full advantage of OpenSpirit functionality. It starts by showing you how to create 

OpenSpirit Sessions and then demonstrates how to retrieve and view data using some of the 
OpenSpirit utilities and viewers. Some features that are not used as often are briefly referenced in 
the Basic Tutorial but covered more specifically in the Advanced Tutorial.

Basic Tutorial

The main entry point to begin using OpenSpirit is the Launcher. The OpenSpirit Launcher is used 
to select data that will be used during OpenSpirit Sessions and to launch OpenSpirit tools and 
OpenSpirit enabled applications from various third party vendors. Data can be combined into an 
OpenSpirit Session, which creates a multi-vendor, multi-version collection of projects. The Session 
acts just as a single project would be used in vendor systems such as GeoFrame and OpenWorks. An 
OpenSpirit Session provides the ability to use data within any number of projects without requiring 
the data to be moved or copied.

Basic Tutorial Lessons Advanced Tutorial Lessons

Using the Launcher Active Servers
Monitoring Server Events
Customizing Menu Items

Working with Sessions Setting Units
Setting Coordinate System
Editing or Deleting
Exiting a Launcher Session

Using OpenSpirit Tools DataSelector
CopySync
Excel Adapter
Well Viewer
Section Viewer
3D Viewer
Event Gateways
Scan Utility
ArcMap Extension

T
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Using the Launcher - Basic

The OpenSpirit Launcher is the main user interface. From the Launcher you can manage your 
OpenSpirit sessions, launch OpenSpirit applications, and monitor OpenSpirit data connectors.

The OpenSpirit Launcher is started by typing ./openspirit in the bin directory of a Unix 
installation, or on a Windows machine from a short cut on your desktop or the Start>Programs menu. 
When you start OpenSpirit for the first time, you will automatically start the OpenSpirit User Setup 
Wizard.

User Setup Wizard

The User Setup Wizard will 
walk you through creating a 
new OpenSpirit user account, 
and configuring your data 
server activation settings. You 
can also use the User Setup 
Wizard any time after the 
initial setup to modify your 
settings. 

Starting the User Setup 
Wizard. The User Setup 
Wizard will be presented to 
you the first time you run the 
OpenSpirit Launcher or 
DataSelector as a new OpenSpirit user. You can also access it through the OpenSpirit Launcher's 
Configuration menu.

Using the Session Wizard. Navigation through the setup steps is accomplished by clicking on the 
Next and Back buttons found at the bottom of each of the User Setup Wizard panels. The Next button 
takes you to the next panel. The Back button takes you to the previously displayed panel. Navigating 
backward using the Back button will not cause you to loose any entries already made.

A Cancel button is available on all of the wizard panels. Click Cancel to close the wizard discarding 
any changes.

The User Setup Wizard walks you through the following panels.

Create an OpenSpirit user. When you start OpenSpirit for the first time, the OpenSpirit User Setup 
Wizard automatically starts. This will register your current Windows or UNIX userid as your 
OpenSpirit primary desktop account. OpenSpirit enters this userid in its internal database and 
uses this area to keep track of your OpenSpirit preferences. These preferences are then available 
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from any host computer that you log onto as long as you log in under the same userid. The New 
User Account Setup will only run the first time you start OpenSpirit.

Secondary Desktop Account Setup. The Secondary Desktop Account Setup panel is presented 
after your OpenSpirit primary desktop account is created. A secondary account may be needed 
if you want to run OpenSpirit applications on Windows and UNIX (i.e. Linux or Solaris) using 
different userids. If your UNIX and Windows userids are the same, then leave the field blank, 
you do not need to configure a secondary desktop account.

When you have different UNIX and Windows userids and you register one of them as a 
secondary desktop account, your OpenSpirit user preferences will appear the same from both 
accounts. The secondary desktop account also allows you to share OpenSpirit interaction 
events, like data selection events and cursor tracking events, between applications running 
under different userids. Normally user interaction events are only shared between processes 
running under the same userid, potentially on different host computers.

For example, if you are running an OpenSpirit enabled application on Windows and your userid 
is "ms-user" and you are also running an OpenSpirit enabled application on Linux using a 
userid "ln-user", you should register one of the userids as your primary account and the other 
as a secondary account. It is best to use the userid you use most often to run OpenSpirit 
applications as your primary account.

A userid cannot be registered as both a primary account and a secondary account. You will need 
to have your OpenSpirit installation administrator use the OpenSpirit User Manager tool to 
delete one of the primary accounts if you mistakenly register both of your userids as primary 
accounts. The userid associated with the deleted primary account will then become available 
for use as a secondary account.

You can un-register a secondary desktop account by blanking out the field and continuing with 
the wizard to a successful finish.

Setup a data server. OpenSpirit has the capability to remotely start application data connectors 
(GeoFrame, OpenWorks, Finder, etc.) across different operating systems such as Solaris and 
Linux. This capability is commonly used when running applications on Windows that need 
access to data that is only available on Solaris or Linux (see Chapter 3). The data connector 
setup panels are used to provide OpenSpirit with the host, account, and password information 
needed to run data connector processes to service requests for data made by OpenSpirit enabled 
applications. The information is encrypted and stored as part of your user preference data in the 
OpenSpirit proprietary database.

Windows data connectors can only be run on a Windows host that is running your OpenSpirit 
Launcher or DataSelector. No data connector setup is needed for Windows data connectors 
(Kingdom, Petra, etc.).

The Data Server Setup allows you to enter a SunOS (Solaris), or Linux host, user account and 
password. This will become the default host for any OpenSpirit data connector that runs on the 
associated platform. The Host entry field contains a Test button on the right of each row that 

Usage Note:

This feature 
requires that the 

rexecd daemon or SSH 
be running on the target 
host. The rexecd daemon 
may be disabled at some 
sites or some computers.
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can be used to validate the host, account, and password entered for the platform default.

If you always want to use this host for every OpenSpirit data store, then check the Use default 
values for all Data Servers radio button. If you leave the default Allow Data Servers to be 
independently configured checked, then when you select Next, you will be presented with a list 
to choose a host for every data store. OpenSpirit data connectors must be able to run in their 
native operating system environment. The host, account, and password should be able to run the 
application outside of OpenSpirit. If you want to change a few of the data connectors use Alt 
and Ctl function keys and click on the Data Sources you want to change and then click on Edit 
selected rows.

Set user passwords. The last step in the OpenSpirit Setup Wizard is an area to set your project 
passwords. This will give you the opportunity to enter project passwords for all the relevant 
projects. OpenSpirit utilizes the access control mechanism of the underlying data source so 
project passwords are only needed if the native application requires them. If you elect not to 
enter project passwords at this time you will be prompted to do so later when you use a project 
that requires one.

• OpenWorks, Recall, Managed Segy and Petra - no account or password is required.

• GeoFrame - a project password is required. You may click, using the right mouse button, on 
the Password column header to set the passwords of all the GeoFrame projects to the project 
name. The Password field will automatically be filled out with the project name. You can 
then edit the password of any GeoFrame project that does not match the project name.

• Finder - Oracle account and password. Externally authenticated Finder accounts cannot be 
used.

• PPDM - Oracle account and password.

• Kingdom - Entering Kingdom passwords depends upon the type of Kingdom project 
database your project uses. If the Kingdom project database is MS Access, enter the 
Kingdom author for both the account and password field. If the Kingdom project database is 
Oracle, the account should be the Oracle database login user followed by a semi-colon and 
then the Kingdom project author name. The password should be the Oracle database login 
user password.

• SDE - Oracle SDE user and associated Oracle password. 

After you have gone through the User Setup Wizard, the OpenSpirit Launcher will open:

The main Launcher window can be expanded to show the full set of features by clicking the Session 
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Manager icon or selecting the View > Session Manager menu item.

Working with Sessions

An OpenSpirit Session is used to define a subset of data source projects that are used to select data. 
Sessions are also used to express a preference of units and coordinate system to be used when 
displaying values obtained from projects in the Session. Applications are not required to honor the 
unit and coordinate system preferences, they are only there to indicate a preference. Some 
applications make use of these preferences and some applications ignore them.

Session Wizard

Sessions are created using the Session Wizard. The Session Wizard is also used to make changes to 
an existing Session. The Session Wizard guides you through the steps of creating a Session, 
including selecting the data source projects and unit and coordinate system preferences. Interpreter 
and source priority preferences are also captured for Sessions that contain one or more OpenWorks 
projects.

Navigation through the Session creation steps is accomplished by clicking on the Next and Back 
buttons found at the bottom of each of the Session Wizard panels. The Next button takes you to the 
next panel. The Back button takes you to the previously displayed panel. Navigating backward using 
the Back button will not cause you to loose any entries already made.

A Cancel button is available on all of the wizard panels. Click Cancel to close the wizard discarding 
any changes.

A Finish button is available on all of the wizard panels if the wizard is being used to edit an existing 
Session. The Finish button only appears on the last panel if the wizard is being used to create a new 
Session. Click Finish to close the wizard saving any changes that have been made. No changes are 
saved until the Finish button is pressed.

Starting the Session Wizard. The Session Wizard is accessed via the Sessions tab in the OpenSpirit 
Launcher and then clicking Edit or Create, or via the OpenSpirit DataSelector's Session menu.

Using the Session Wizard. The Session Wizard will create an OpenSpirit Session after it walks you 
through the following panels. The panels can also be used to edit an existing Session.

Session general properties. Enter a Session name and optionally a description. The name must be 
60 characters or less and may not contain spaces or special characters such as $#'()"%. The 
description can be up to 256 characters and may contain spaces and special characters. The 
name cannot be changed after the Session is created. The description can be changed at any 
time. Click the Next button after you have entered your Session name and description.

Session project(s). Choose the projects you want to access using this Session. You can combine data 
from one or several diverse project data sources into a single Session. The tree on the left side 

Security Note

You will only see 
data sources that 

have been configured at 
your site and projects to 
which you have access 
based on the security 
mechanism of the 
underlying vendor 
system and based on the 
userid running your 
Launcher process. The 
expanded tree will look 
different depending on 
what data stores are 
configured at your site 
and which projects are 
available for you to use.
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of the panel organizes all of the available projects in a hierarchy of data store type, data store 
instance, and project. The tree does not display projects that you do not have permissions to 
access.

Expand the tree to select a project. The right arrow will turn blue when you select a project of 
interest. Press the right arrow to add the project to your Session. Projects that are already in the 
Session will appear green and will be in the list on the right of the panel. Projects not included 
in the Session appear brown in the tree. You can remove projects from the Session by selecting 
them from the list on the right side and clicking on the left blue arrow.

It is best not to add unnecessary projects to your Sessions as there is an overhead for each 
additional project. After you have picked the project(s) you are interested in, click Next which 
will take you to the Passwords panel or to the Units panel.

Passwords. This panel gives you the opportunity to enter passwords for all projects included in the 
Session that require an account and/or password to access. The panel will not appear if none of 
the projects selected for inclusion in the Session require account or password information.

OpenSpirit utilizes the access control mechanism of the underlying data source, so accounts and 
passwords are only needed if the native application requires them. Projects in the Session that 
do not require account or password information will not appear on this panel.

• OpenWorks, Recall, Managed Segy and Petra - no account or password is required.

• GeoFrame - a project password is required. You may click using the right mouse button on 
the Password column header to set the passwords of all the GeoFrame projects to the project 
name. The Password field will automatically be filled out with the project name. You can 
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then enter information for any non-GeoFrame projects or edit the password of any 
GeoFrame project that does not match the project name.

• Finder - Oracle account and password. Externally authenticated Finder accounts cannot be 
used.

• PPDM - Oracle account and password.

• Kingdom - Entering Kingdom passwords depends upon the type of Kingdom project 
database your project uses. If the Kingdom project database is MS Access, enter the 
Kingdom author for both the account and password field. If the Kingdom project database is 
Oracle, the account should be the Oracle database login user followed by a semi-colon and 
then the Kingdom project author name. The password should be the Oracle database login 
user password.

• SDE - Oracle SDE user and associated Oracle password. 

After your Passwords have been set, click the Next button which will take you to the Units 
panel.

Units. You can optionally set preferred units for the Session. Some applications will honor the unit 
preferences and some will not. It is the individual application's decision. The unit preferences 
will default to a set of metric units if you do not make any selections on this panel.

Note that most applications use the coordinate system axis units for spatial X, Y, and Z location 
data. Many applications may only use the horizontal and vertical distance units for offset 
distance values. Consult with your application vendor if you are uncertain about how they are 
making use of these unit preferences.

After you have chosen your units, click Next which will take you to the Coordinate System 
panel.

Coordinate System. You are required to set a preferred coordinate system for the Session by 
designating which project coordinate system you want to use. Click on the check box in the 
select column to select the project's coordinate system.

The project data must be accessed to obtain a description of its coordinate system when the 
project's check box is selected. A data connector process may need to be started at this time. 
This can take anywhere from a few seconds to a couple of minutes to start depending on the 
type of data source and the processing speed and load of the computer that is used to run the 
data connector. The wizard will wait a fixed amount of time for the data connector process to 
start. An error message will be displayed if the data connector fails to start within the allotted 
time. It is possible that the data connector startup process will continue after you encounter a 
time-out error message. A second attempt at enabling the check box will usually succeed if the 
first attempt fails due to slow data connector start time.

Once the data connector is started the name of the selected project's coordinate system will be 
displayed below the list of projects. You can then click on the Details button if you would like 
to inspect the parameters used to define the project coordinate system.

Usage Note: 
OpenSpirit 
enabled 

applications are 
responsible for deciding 
the preferred Session 
units and coordinates. 
In many situations, 
vendor applications may 
have their own 
mechanism of setting the 
application display 
units and coordinates, 
and can therefore ignore 
any OpenSpirit 
preferences that may 
already exist.



14

CHAPTER 2 OpenSpirit Tutorial

Click the Next button after you have chosen your coordinate system. This will take you to either 
the Interpreters panel or the Ready to save panel which is the last panel displayed by the wizard.

Interpreters. The Interpreters panel appears after pressing the Next button on the Coordinate 
System panel if your Session includes any OpenWorks projects. This panel is used to optionally 
establish the OpenWorks interpreter to be used when manipulating data in an OpenWorks 
project. Setting the Interpreter ensures the proper identification and storage of newly created 
OpenWorks interpretation data. You are not required to select an interpreter, but are strongly 
encouraged to do so if you intend to create any OpenWorks interpretation data using this 
Session.

You can select an interpreter for a subset of the displayed OpenWorks projects by highlighting 
one or more projects and clicking on the Select Interpreter button. OpenSpirit will then query 
OpenWorks and present you with a list of all the available interpreters common to the selected 
projects. A data connector process may need to be started at this time. This can take anywhere 
from a few seconds to a couple of minutes to start depending on the type of data connector and 
the processing speed and load of the computer that is used to run the data connector.

Select an interpreter from the list that pops up once the OpenWorks data connector has been 
queried. An error dialog will be displayed if there is not at least one interpreter common to all 
of the selected projects.

Click the Select Interpreter For All button if you want to use a single interpreter for all of the 
displayed OpenWorks projects. This is merely a convenience feature that saves you the effort 
of highlighting all of the projects. The interpreter selection list will only contain interpreters that 
are common to all of the listed projects.

Click the Next button after you are finished setting your interpreter preferences. This will take 
you to the Source Priority panel.

Source Priority. The Source Priority panel is displayed if your Session includes any OpenWorks 
projects. The Source Priority panel enables you to create and associate a source priority list for 
each OpenWorks project included in your Session. A source priority list defines a ordered list 
of preferred interpreters used when retrieving like data. It is taken into consideration by business 
logic in the OpenWorks data access libraries. It affects decisions used in determining what well 
pick is used if picks have the same name but different interpreters.

You are not required to enter source priority information and many applications do not make use 
of this information. Consult your application vendor to determine if they make use of the source 
priority information when requesting data from OpenSpirit.

Click the Next button after you are finished setting your source priority preferences. This will 
take you to the Ready to save panel which is the last panel displayed by the wizard.

See the Data Selector / General Preferences Section for instructions on how to turn on the 
Source Priority functionality.

Ready to save. The Ready to save panel is the last panel displayed by the Session wizard. It is your 
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last opportunity to make any changes before the current settings are saved. Press the Finish 
button to save the entries made on the previously displayed panels. Press the Back button if you 
would like to go back to a previous panel to view or change any entries. Pressing Cancel will 
discard any changes made and will exit the wizard.

You have just successfully completed the creation of an OpenSpirit session and it will appear in the 
Launcher. With this session you can use the OpenSpirit DataSelector or other applications to work 
with data in the selected projects.

Using the Launcher - Advanced

More Launcher Features

The OpenSpirit Launcher includes some additional features to allow an end user to monitor and 
control an OpenSpirit session and its associated processes. 

Active Servers

A series of data connectors are used during an OpenSpirit session. These data connectors are 
automatically started, as required, and perform the job of serving up the requested data to OpenSpirit 
enabled applications and user tools. To see which connectors are running at any point in time during 
a session, you can select the Active Servers tab. This tab shows all the active data connectors for the 

Active Servers

Monitoring Server Events

Customizing Menu Items
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current user.

The Active Servers tab is automatically updated as data connectors are started and stopped. 
Individual data connectors may be shutdown by selecting the desired row and clicking the 
Shutdown... button. 

All data connectors may be shutdown by clicking the Shutdown All... button. 

Note that even after being manually shutdown, a data connector will be automatically launched 
again if it is required to deliver data to a requesting application. You also have a chance to shutdown 
all the data connectors when exiting the Launcher.

Monitoring Server Events

Data Connector events can be monitored in the Server Events tab. This tab can be helpful should 
problems arise when starting a Data Connector.

Customizing Menu Items

The Tools, Applications, and Help menus are all customizable on a site or individual basis. The menu 
entries are controlled by the contents of the $OSP_HOME/classes/Launcher.properties file. The 
Launcher.properties.README file, contained in this directory, explains how the Launcher.properties 
file may be edited in order to change the menu items that appear in the Launcher’s menus.

Usage Note:

Shutting down 
connectors that 

are being used by 
running applications 
will likely cause errors 
in those applications. 
Close all OpenSpirit 
applications before 
shutting down any 
OpenSpirit data 
connectors.
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Exiting a Launcher Session

When you are finished with your session, quit 
the Launcher using the File > Exit menu...

If you will not be using any OpenSpirit based 
application for some period of time, you would 
normally choose the Shutdown my data server 
processes option. If you are quitting OpenSpirit 
but plan to start a session soon with the same 
ProjectSet then Do not shutdown any server processes is the recommended choice.

Usage Note:

If your site is 
application 

license constrained, it is 
best to shut down your 
connectors when you 
exit the Launcher. 
Vendor data connector 
licenses are not freed 
while connectors are 
running. Also, some 
projects might be single 
user and other users 
won’t be able to access 
the project if connectors 
are left running.
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Using OpenSpirit Tools

OpenSpirit includes a set of user tools that is intended to provide basic viewing capabilities to verify 
data quality, help select data for use in other applications, and illustrate the effective use of 
OpenSpirit. Application vendors may choose to use these tools in workflows involving their own 
applications. These tools are also useful to verify that an OpenSpirit installation has been correctly 
configured.

Using the DataSelector

Using the CopySync

Using the Well Viewer

Using the Section Viewer

Using the 3D Viewer

Using the Event Gateways

Using the Scan Utility

Using the ArcView Extension

Windows Note:

These tools are 
written in Java 

and can run on either 
Windows, Solaris or 
Linux
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Using the DataSelector

Tool Overview

The DataSelector is a data selection and query utility that presents a tabular summary of selected 
attributes associated with the data types that are supported by the OpenSpirit Framework. The 
DataSelector can be used to query for specific information from different data sources. The main 
functions of the tool are:

Title Bar

The Title Bar shows the current session. If the DataSelector is connected to a Session it can share 
events to and from other OpenSpirit applications as well as OpenSpirit enabled vendor applications. 
If a session is set in the OpenSpirit Launcher prior to starting the DataSelector tool, then all the 
projects included in the Session will be selected and displayed in the Project tab.

Menu and Tool Bar

The Menu and Tool Bar provides various functionality that is needed when you use the DataSelector. 

Data selection

Data query

Event Sending and Receiving

CHAPTER 2 OpenSpirit Tutorial
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Tool Bar

Work Area
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The commonly used menu items are included in the Tool Bar.

Tool 
Bar
Icon

Menu
Item

Function

File> New... Create a new file to save the data selections.

File> Open... Open an existing file.

File> Save... Save changes that have been made.

File> Save As... Save changes that have been made with a new filename.

File> Exit Exit the DataSelector.

Session> New Starts the Session Wizard so a new session can be created.

Session> Open Presents a list of sessions so the user can select an existing session for 
use in the current DataSelector

Session> Edit Presents a list of current sessions. When the user selects a current 
session, the Session Wizard is started with the selected session. When 
edits are finished, the edited session will be used by the DataSelector.

Session> Delete Presents a list of current sessions the user can pick to delete.

View> Refresh Refresh the data in the current tab by requerying for data.

View> Stop Refresh Cancel the display refresh or the data query that is currently underway.

View> Remove 
Received Data 
Selections

Remove data selections that have been received via an event broadcast

View> Select All Mark all rows in current tab as selected.

View Clear All De-Select all rows that are selected in the current tab

Display the Data Scope dialog associated with the current tab

CHAPTER 2 OpenSpirit Tutorial
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Work Area

The work area is divided into 4 domains (Wells, Seismic, Interpretation and Culture) each 
comprised of different tabs for each supported data type. Only one domain and one tab is active at 
a time. Each tab lists supported attributes for the specific data type in each column. Columns can be 
added or removed and sorted or moved as desired. Within each tab you can make data selections that 
may impact other tabs.

View> Tab Preferences Display the dialog for setting tab preferences. These preferences apply to 
just the current tab.

View> General 
Preferences

Display the dialog for setting global tab preferences. These preferences 
apply to all tabs.

Toggle (on/off) listening for selection events for current tab.

Event> Broadcast 
Selection Event

Send a selection event for all the selected rows in the current tab.

Event> Broadcast 
Selection Event (All 
tabs)

Send a selection event for all the selected rows in all the tabs.

Help> DataSelector 
Help

View this document.

Help> About Displays OpenSpirit version information.

Displays a description of the information in the current selected tab.

Copy Manager These icons control the Copy Manager Utility. A separate 
section will describe how to use the Copy Manager Utility.

Tool 
Bar
Icon

Menu
Item

Function

Usage Note: The 
Culture domain 
tab will only 

display if you have 
included a SDE project 
via the SDE Culture data 
connector.
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General Preferences

The DataSelector preferences can 
be set in the General Preferences 
dialog. The General Preferences 
dialog can be accessed via the 
General Preferences icon or 
through the View > General 
Preferences menu item. For each 
domain you can turn tabs on or off, 
select the type of selection events to 
send and receive; and set 
preferences for the coordinate 
system, unit system and the Query 
Builder mode.

The Preferences section controls 
preferences for all Tabs. The first 
dialog box controls the units (feet, 
meters, etc.) you will see in the 
DataSelector tabs. It defaults to Use 
Project Units. In this mode, the 
DataSelector will display the units 
exactly as they are in the native 
project. You can also choose to 
display them in Imperial, metric, or 
translate everything to Session 
units.

By default the data displayed in the 
DataSelector uses the project coordinate system. In this mode, if you have data displayed in the Data 
Selector from multiple projects the original coordinate system from its native project is used. This 
can result in multiple coordinate systems displayed in the DataSelector at one time. If you want all 
of the data items displayed in the same coordinate system select the Use Session Coordinate System 
checkbox sets. In this mode all coordinate systems in the DataSelector tab are translated to the 
Session's coordinate system selected when the Session was created.

The query capability for the DataSelector is also controlled in the General Preferences. If you wish 
to use complex queries (and, or, nor) select the Use Advanced Query Builder checkbox. By default 
the query capability uses a basic query builder.

The Use Source Priority from session checkbox implements a session's Source Priority List for 
OpenWorks derived picks only. When checked the Source Priority List is used to determine the Well 
Picks displayed in the Well Picks tab.

The final checkbox controls the warning dialog that pops up if you have none of the tab's parent 
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items selected, and you are going to have no data displayed. Check the Display warning dialog if no 
items are selected in data scope box if you do not want this warning displayed.

Adding Columns

Each tab will initially display a 
default set of attributes for the 
specific tab’s data type. You can add 
additional attributes (columns) or 
remove existing ones by selecting the 
Tab Preference  icon or the 
View>Tab Preference menu item. 
This will display a dialog with all the 
attributes that can be selected in the 
active tab. You can use the Ctrl and 
the Shift key with the mouse to select 
and deselect multiple columns. The 
Revert to Defaults button will restore 
the tab's default setting and provide 
the fastest performance.

Sorting Columns

Columns can be sorted by clicking the right mouse button on the 
top of the column you want to sort. This will display a menu 
where you can select ascending or descending order.

Moving Columns

Move columns by clicking and holding down the left mouse button at the top of a column where the 
attribute label is displayed, dragging it where you want and then letting up on the left mouse button. 
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Data Selections

Each tab’s label designates the type of queries used within the tab. There are different types of 
queries.

Each tab has a special column named Origin. This column will normally be the left most column 
unless you have moved columns around from their default position. The Origin column designates 
what kind of selection the row came from. The different types of selections are described earlier in 
the chapter.

Data Scope

The Data Scope dialog is used to determine the scope of the data seen in each tab of the DataSelector. 

Select from selected parent This selection uses the tab’s parent tab to determine what is selected. 
It is the default selection and is designated by no icons in the tab label 
section. 

.

Select from selected 
projects

This selection is set by selecting this option in the Tab Preferences 
dialog and is made on each tab individually. When this is selected an 
icon is displayed in the tab label section. 

This example shows the Well Bore tab using 
the selections from the Project tab.

Select from selection events This selection can be used to listen to other applications sending 
selection events. This option can be used in conjunction with the 
previous option to combine selections from the parent tab. Select this 
option by clicking on the lightning bolt in the Tool Bar.

This is an example of the WellBore tab set to 
listen for selection events and also getting 
selections from its parent Project tab.

Add data selection filters This selection can be used to further filter data. For example, you 
could make a query to show all the Well Bores with active status or all 
the Well Bores deeper than 5000 ft. You can also combine any 
number of filters.

This example shows the Well Bore tab set to 
listen for selection events, get selections from 
its parent Well tab as well as additional filters 
being applied to the resulting selection.
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The data scope can be a combination of selected parent, user constructed simple or complex queries 
and spacial filtering. Access to the Data Scope dialog is available on all tabs except the Project tab. 
(The Project tab is used to select projects and is explained later in the section on the Project tab.)

This shows an example of setting 
the data scope for the WellBore tab. 
The selected parent is Project, there 
is a simple user constructed query 
and spacial filter is off. The results 
of this would be to display all the 
Well Bores contained in the 
selected Project(s) in the Project 
Tab where the status is active and 
the Total Depth is greater than 7000 
feet.

Any number of queries can be 
joined together using the Basic 
Query Builder.

The Query Builder is described in 
more detail later in this chapter.

Spatial Filter

In the Wellbore tab (Well domain) 
and the Point, Polyline or Polygon 
Feature (Culture domain), in 
addition to filtering based on 
attribute values, you may also query 
based on surface location and area of interest. For both well and culture data you may type in a 
simple bounding box (x,y’s in the session’s preferred coordinate system) to define the area of 
interest or you may listen for GIS Feature selections.

For wellbores if you chose to 
listen to GIS Feature selections 
then you may send any set of 
polygonal GIS features from 
ArcView using the OpenSpirit 
Extension for ArcView. The 
polygons may be complex multi-
part GIS polygons with holes. 

You may wish to send polygons that correspond to 3D survey boundaries, OCS lease blocks, 
company leases, or any other polygonal feature. The names and layer names of received features are 

Usage Note: 
Clicking the 
right-mouse 

button on the tab opens a 
pop-up menu where you 
can quickly change the 
data scope without 
having to open the Data 
Scope dialog.
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displayed in the GIS Feature Selection dialog. Toggle the checkbox on next to those features that 
you wish to use in defining your area of interest. Then when the OK button is pressed on the wellbore 
query builder tab a query will be issued to retrieve all wellbores within the specified data scope that 
are within any of the GIS polygons AND whose attribute values satisfy the indicated attribute 
constraints (if any). 

For culture data when a GIS selection event is sent the bounding box is computed as a bounding box 
that encloses all received GIS features. Note that sending data selection events for these culture data 
items is different from the GIS Feature Event that may be sent from the OpenSpirit ArcGIS 
Extension. A GIS Feature selection event contains the feature name and its geometry whereas a data 
selection event for a culture feature contains a reference to a feature which allows a receiving 
application to get any of the feature's attributes - not just its name and spatial location. 

If the DataSelector state is saved (using the File-> Save option) then all the points of any selected 
polygons are also saved so that the full selection criteria may be reapplied any time the save file is 
re-opened.

Data Hierarchy

The overall data hierarchy that is used by the DataSelector is described by the following flowchart. 
This hierarchy governs what data will be displayed in each subsequent tab. For example if five 
wellbores are displayed in the Well Bore tab and you select (highlight) only one of them, going to 
the Well Log tab you will only see logs from that one wellbore.

Usage Note: In 
order to do 
spatial filtering 

you must first set, in 
General Preferences, 
the coordinate system 
preference to indicate 
that you wish to use the 
Session coordinate 
system (which should be 
set in the session 
manager on the 
Launcher). This will 
allow spatial filtering to 
be done across projects 
that may be using 
different coordinate 
systems.
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Project Tab

The Project tab allows you to select the projects you want to browse. There are three ways to select 
or change projects in the Project tab.

If you would like to select individual projects instead of projects within a Session, you can select/
highlight just the desired project.

A selected project will look like this  in the Project tab.

If you want to add or remove projects from the existing session, you can select the  icon. This will 
start the Session Wizard and the Session project(s) dialog, where you can add or remove projects, 
will open. When completed just press the Finish button and the DataSelector will be updated.

The Session menu in the DataSelector toolbar will allow you to create new sessions, replace the 
current session with another session and edit a session. The Session> New menu item will launch 
the Session Wizard and you can create a new session with new projects. When finished, the new 
projects will be in the Project tab. The Session> Open menu item, will open an existing session and 
put its projects in the Project tab. The Session> Edit will launch the Session Wizard with the current 
session. After you have edited the current session, its projects will be presented in the Project tab.

Query Builder

The DataSelector's query function allows you to create queries to specify the criteria for selecting 
data items in order to constrain the number of data items to be returned. You can query for items 
based on names, projects, and much more. The Query Builder dialog in the General Preferences 
dialog allows you to select the type of query builder to use when constructing queries. The difference 
between the Basic and Advanced Query Builder dialogs is in the way the queries are constructed and 
displayed.

Select the projects from selected Session.

Use the Data Scope icon  to add or remove projects from the 
current session.

Use the Session menu to create a new session, open an existing 
session, or edit the current session.
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Basic Query

The Basic Query Builder is used to construct simple queries that are bound by the AND operator. 
To construct a query you would select the column to query on using the column drop-down menu. 
The Column selection contains all of the queryable columns for the current tab. After selecting the 
query Column, you would next select an Operator. These operators will also change depending on 
what column is selected to query on. Finally you would type-in the value you want to query against. 
To add a query to the Builder press the Add button. Existing queries can be modified by selecting 
the query in the Builder and pressing the Modify button. To delete an existing query select the query 
and press the Delete button.

This query would result in 
displaying all the Well Bores where 
the BoreStatus is active AND the 
Total Depth is greater than 7000 feet

Advanced Query

The Advanced Query Builder allows you to build queries without being constrained to the use of 
the implicit AND operators. You can build arbitrarily complicated query structures using a mixture 
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of AND, OR and NOT operators. 

The Advanced Query Builder is more complicated to use than the Basic Query Builder because of 
the use of the Query Tree when constructing the query. The Query Tree uses a tree notation to display 
a constructed query. You can use the View Query button to see the generated query at any time.

How to use Relational Operators

The Relational Operators in the Advanced Query Builder are used to create queries. The Column 
selection contains all of the queryable columns for the current tab. You can query for different 
columns for different tabs. The Operator drop down box contains the different operators that can be 
applied to the selected column. Not all columns offer the same set of operators so you won’t see the 
operators until you have selected the column.

A query is constructed by selecting a column in the Column selection, applying an Operator and then 
giving it a value. To add a column to the Query Tree press the Add button after the Operator and 
values have been selected. The DataSelector will give an error message if any of the fields are 
missing or if a value has been constructed using an incorrect data type (e.g. a non-number has been 
added for a depth).

The use of the Relational Operators panel is straight forward. The following table shows the different 
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operators offered for each supported column type.

like operator

The like operator can be applied to string and string sequence types. It follows the regular expression 
paradigm and can be very powerful. The table below lists important meta characters that can be used 
when building regular expressions using the like operator.

Column type Operators supported

String =, !=, like, in, IS NULL, IS NOT NULL

Integer and numbers =, !=, <, <=, >, >=, IS NULL, IS NOT NULL

String arrays like, in, IS NULL, IS NOT NULL

Boolean =, !=

. Matches any single character. For example the regular expression r.t would match the 
strings rat, rut, r t, but not root.

*
Matches zero or more occurrences of the character immediately preceding. For example, 
the regular expression .* means match any number of any characters.

+
Matches one or more occurrences of the character or regular expression immediately 
preceding. For example, the regular expression 9+ matches 9, 99, 999.

? Matches 0 or 1 occurrence of the character or regular expression immediately preceding.

[A-Z] Matches any single alphabetic character in the range A to Z. 

[^D,A-Z] Matches any single alphabetic character in the range A to Z, except the “D” character. 

[0-9] Matches any single numeric character in the range 0 to 9.

[0,2,3,6] Matches any single numeric character among the listed ones.

[0-9][0-9] Matches any two numeric characters in the range 0 to 9.
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Here are some examples.

Example 1) A query that matches all Last Modified dates in 2001, month of January, any day in 
January and any time at 11 AM.

Example 2) A query that matches all Operators ending with OIL (e.g. MAJOR OIL):

Example 3) A query that matches all Operators beginning with MAJOR (e.g. MAJOR OIL).

Example 4) A query that matches all Wells beginning with “WELL UWI” followed by exactly one 
numeric character (e.g. “WELL UWI 7”).

Example 5) A query that matches all Wells beginning with “WELL UWI 15” followed by one or more 
numeric characters (e.g. “WELL UWI 1515”, “WELL UWI 1516”).

Example 6) A query that matches all Wells beginning with "WELL UWI 15" followed by zero or more 
numeric characters (e.g. "WELL UWI 15", "WELL UWI 150", "WELL UWI 1510").

Example 7) A query that matches all Wells beginning with "WELL UWI 15" followed by exactly two 
numeric characters (e.g. "WELL UWI 1500", "WELL UWI 1501", "WELL UWI 1510").
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in operator

The in operator can be applied to strings and string arrays. 

How to Build Queries

The Following steps show how to construct a complex query in the Well Bore tab.

Example 8) A query that matches all Operators ending with exactly three characters containing any 
of the characters ".", "I". "N", "C" (e.g. "PASCO INC ", "MAJOR INC.").

Example 9) A query that matches all Operators not ending with the "O", "I", "L" characters (e.g. 
"MAJOR INC.").

A query that returns all data items in the BVILLE and BRACE_N_BIT projects.

Select the TD column, > operator and type in 6000 in the value column. Press Add.

Press the AND button and then select the newly added AND node in the Query Tree.

Select the TD column, < operator and type 9000 in the value column. Press Add.

Press the OR button and then select the newly added OR node in the Query Tree.

Select the ProjectName column, = operator and type FIELDA as the value. Press Add
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Modify a Query

Both the Basic and Advanced Query Builder give you the ability to modify existing search criteria. 
This is done by first selecting a row in the Basic Query Builder or a node in the Advanced Query 
Builder, and then go to Relational Operators to modify any of the components in the selected search 
criteria and then press Modify to update the search criteria.
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Using the Copy Manger

Tool Overview

The Copy Manager is a utility that copies well, seismic and interpretation data between OpenSpirit 
enabled data stores. The types of data that can be copied are as follows:

The Copy Manager moves data to and from OpenSpirit enabled data stores. The Copy Manager 
interface is started from the DataSelector. The menu and tool bar items include.

Well Data: • wells
• well bores
• picks
• logs
• velocity (time/depth)

Seismic 
Data:

• 3D surveys
• 3D volumes
• 2D surveys
• 2D lines
• 2D datasets

Interpretation 
Data:

• 3D seismic horizons

• 2D seismic horizons
• non-seismic grids
• fault polylines

Tool 
Bar 
Icon

Menu
Item

Function

Copy Manager> Copy Manager 
Manager...

Display the Copy Manager dialog

Copy Manager> Submit Copy Job... Submit created copy jobs

Copy Manager> Task Controller... Display the Task Controller dialog
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The Copy Manager works in concert with the DataSelector. First select the data you want to copy 
using the DataSelector and all its query functionality and then setup a copy job to define the target 
project where you want to copy to.

Copy Manager Dialog

A Copy Job is the terminology used to describe what is to be copied, where to copy the data, and 
how the copying is controlled via Copy Criteria. The copy job is a description of what is to be 
copied. Build a copy job by selecting data in the DataSelector tabs and then use the Copy Manager 
dialog to:

Select Destination Project.

Select Log File Directory and log file options.

Select Copy Controls
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The Copy Manger dialog is split up into four sections: (1) Preferences, (2) Destination Project (3) 
Copy Rules and (4) Copy Data.

Preferences

Log Directory: Select the directory where the copy job log files are to be written. By default the 
logs will be written to your $HOME/OpenSpirit/CopySync directory on UNIX and C:\Documents 
and Settings\<user>\OpenSpirit\CopySync directory on Windows.

Server Control: Tells the copy job whether to shut-down the data connectors after the copy job is 
completed or leave them running.
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Destination Project

Set what project the data will be copied into in the 
Destination Project section. To select the 
destination project click on the Select Project 
button. 

This will display a dialog that presents a tree view 
of all the possible data store types configured in 
your OpenSpirit installation. Drill down into each 
data store type and expand the folders until you 
find the destination project. This is where all the 
selected data will be copied.

Copy Rules

If the Overwrite existing objects checkbox is selected then during the copy job if the data item to be 
copied already exists in the target project, the data item in the target project will be overwritten with 
the new data item from the source project. 

OpenSpirit uses key rules to determine if an object currently exists in the target data store prior to 
attempting to copy the object. The key rules vary between different data stores. The following table 
describes the current key rules:

Data Store Well Well Bore Well Pick Well Velocity

OpenWorks Identifier Well
Identifier

Bore
PickName
Interpreter
Pick ValueMD

Bore
WellVelocityName

Usage Note: 
Project access is 
limited to those 

projects the current user 
has access to. If you 
select a project and have 
not already entered the 
password, you will 
prompted for the 
password before 
proceeding.
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The exception to overwrite existing objects is well logs and well picks. Well logs are never over 
written. If a log of the same type, depth, and in the same well already exists, then it is still copied 
and the version is incremented. Well pick updates depend on the source and destination data stores. 
Some data stores support multiple picks in a well, while others do not, below is a table of the various 
well pick keys for each supported data store:.

For example, in Finder one bore can have two well picks with the same name, same interpreter but 
at different depths. When you attempt to copy these two picks to OpenWorks the first one will get 
copied however the second one will fail because the PickValue MD key is not part of the OpenWorks 
well pick key.

Special Interpreter Alias Rule

If OpenWorks is picked as the target project an addition Copy Rule is available; “Use interpreter 
alias file:” The Use interpreter alias file allows you to define a lookup table external to the 
CopySync tool that will be used to translate source Interpreters to target Interpreters (OW Interpreter 
roles).   This external lookup table is a simple ASCII file that maps a list of source interpreters to 
corresponding (5 character max) OW interpreters. When CopySync runs it reads this file and writes 
data to OW using the mapped OW interpreter. If this interpreter does not exist in the target OW 
project it will be automatically created. Since all new interpreters will be made as PUBLIC, you will 
need to manually change them to PRIVATE, if required, after the copy.

GeoFrame Identifier Well
Identifier

Bore
PickName

Bore
WellVelocityName

Finder Identifier Well
Identifier

Bore
PickName

Bore
WellVelocityName

Kingdom Identifier Well
Identifier

Bore
PickName

Bore
WellVelocityName

Petra Identifier Well
Identifier

Bore
PickName

NA

OpenWorks GeoFrame Finder Kingdom Petra

Bore
Interpreter
PickName
Occurrence

Bore
Interpreter
PickName
PickValue MD

Bore
PickName
PickValue MD

Bore
PickName

Data Store Well Well Bore Well Pick Well Velocity
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Following is an example of a interpreter alias file:

Ab123456 cjl
Ab178998 jep
Ab189998 mattk

Copy Data

The Copy Data section has tabs relating to the different data types that may be copied. There are also 
Copy Rules associated with each data type that are stated in detail later in this section. The selection 
of the Destination Project will determine what data type tabs are active. For instance if you select a 
Finder project for your destination then only the Well tab will be active, if you select an OpenWorks 
project for the destination project then all three tabs (Well, Seismic, Interpretation) will be active. 
Each tab provides for selecting the different types of data to be copied. Refer to the beginning of this 
section for the types of data that can be copied.

Wells

Within the Well tab select to copy Well Bores, Well 
Logs, Well Picks, and Well Velocity data. 

Seismic

Within in the Seismic tab select to copy 3D 
Surveys, 3D Volumes, 2D Surveys, 2D Lines and 
2D Datasets.

Copy rules and known issues associated with 
Seismic data are:

General

• The source and destination 3D surveys are 
checked for compatibility before copying 3D 
volumes. The source survey must be equal or a subset of the destination survey. 

• The surveys must have the same inline and crossline increments. 

• The survey XY values at the four corner points must be within 100 meters of each other as a 
sanity check. More than 100 meters different usually indicates an incompatibility problem 
between the source and destination project's coordinate systems. For example, copying data 
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from a North Sea coordinate system to a Gulf of Mexico coordinate system doesn't make 
sense.

• The source and destination 2D lines are checked for compatibility before copying 2D datasets. 
The 2D lines must have the same number of control points and the XY values along the line 
must be no more than 100 meters different.

• Business rules are used to honor the copy as closely as possible. For example, BRICK 
volumes are only supported in OpenWorks/SeisWorks but it is possible to copy a BRICK 
volume to another vendor format in which case the data will be saved as an inline-optimized 
TRACE volume. If a data type is not supported then the next available data type will be used 
which doesn't result in loss of precision. For example, IESX doesn't support 32-bit integer but 
SeisWorks does. The data will be copied and FLOAT format will be used. Names of surveys, 
volumes, or lines are sometimes changed to honor limitations in the target data store. We 
attempt to name the data as close as the target data set will allow.

• Null seismic traces, traces that are all zeros, are not copied to the destination seismic data file 
to save space.

• Copy will truncate the length of the name if the source project is greater than what is supported 
in the destination store. In some cases, a sequence number may be appended to the name to 
maintain uniqueness.

IESX/Charisma

• Cannot create IESX, Charisma, and SEGY SLICE volumes 

• Cannot create IESX or Charisma crossline-optimized volumes 

• Charisma CDP and Shotpoint values must be integers and have an increment of one 

• Currently do not support writing horizon grids to Charisma if the survey has a negative inline 
or xline delta 

OpenWorks/SeisWorks

• Clients need read/write access to the plist.dat file since the act of creating 2D/3D surveys is 
equivalent to creating a new SeisWorks project.

• If the client's DISPLAY environment variable isn't set by the .login scripts then a $HOME/
osp.DISPLAY file needs to be created that has the X display identifier (e.g. 
10.10.10.123:0.0). The X display is required by a SeisWorks utility that is used to associate the 
OpenWorks 2D lines with the SeisWorks project

• SeisWorks CDP values must be integers and have an increment of one 

• SeisWorks projects are either 2D or 3D. 2D and 3D datasets are not found in the same project 

Special Copy Procedures for OpenWorks/SeisWorks

There are special procedures needed to copy 3D and 2D seismic data to a OpenWorks/SeisWorks 
project. 

For 2D seismic use the following steps:
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1. In the DataSelector select the Project, 2D survey(s), 2D line(s) and 2D dataset(s) to copy.

2. In the Copy Manager select as destination an OpenWorks project. This OpenWorks project 
will be used to select existing associated SeisWorks projects, or will be associated with newly 
created SeisWorks projects. All of the 2d lines selected will be copied into this single 
SeisWorks project. Note that each 2d copy job can be copied to one, and only one 2d 
SeisWorks project. If you want to go to separate SeisWorks projects, then it will have to be run 
in a separate copy jobs for each project.

3. After you have selected the OpenWorks project in the CopyManager, and the OpenSpirit 
OpenWorks data connector has started, click on the Seismic tab. Select 2D Survey, 2D Line, 
and 2D Dataset. At the bottom of the Copy Manager, Seismic tab, you will see a Select Seismic 
Projects... button. Click on the button and this will launch the Seismic Project Selection dialog 
box like the one below.

4. Enter survey information in the Seismic Project Selection dialog (above). This information will 
be used to create a new SeisWorks project, or write the 2D data into an existing SeisWorks 
project. 

a. Select the target SeisWorks project. In the Target Seismic Project field, use the pull-down 
menu to select an existing SeisWorks project.   If you want to make a new SeisWorks 
project, enter an eight character name for the project in the Target Seismic Project field.

b. Select a SeisWorks 2D master project. In the Master Project field, use the pull-down menu 
to select an existing SeisWorks master project.   If you want to make a new SeisWorks 
master project, enter an eight character name for the project in the Master Project field.

c. Select a target Survey name. In the Target Survey Name column, use the pull-down menu to 
select a Survey name. If you want to make a new SeisWorks survey, enter an eight character 
name for the survey in the Target Survey Name field. Click OK in the Seismic Project 
selection dialog box to save your 2D SeisWorks target information.

5. Submit the copy job.

6. If you are creating 2D lines and 2D datasets in multiple SeisWorks 2D projects, you must 
shutdown the OpenWorks data connector after each copy job. To do this, toggle on the 
Shutdown dataservers after copy selection in the Preferences section of the Copy Manager.

For 3D seismic use the following steps:
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1. In the DataSelector select desired Project, 3D Survey(s) and Volume(s) to copy.

2. In the Copy Manger select as destination the target OpenWorks project. Please note that due 
to Landmark's data structure, a new SeisWorks project must be created for every seismic 
survey.

3. After you have selected the OpenWorks project in the CopyManager, and the OpenSpirit 
OpenWorks data connector has started, click on the Seismic tab. In the Seismic tab, select 3D 
Survey and 3D Volume. At the bottom of the Copy Manager, Seismic tab, you will see a Select 
Seismic Projects button. Click on the button and this will launch the Seismic Project Selection 
dialog box like the one below.

4. Enter survey information in the Seismic Project Selection dialog (above). This information 
will be used to create a new 3D SeisWorks project, or write the 3d data into an existing 3d 
SeisWorks project.

a. Select the target 3D survey. In the Target Survey Name column, use the drop-down menu to 
select an existing 3D survey associated with the source OpenWorks project selected earlier. 
If you want to use a different name for the new 3D survey enter a unique name (up to 30 
characters) in the Target Survey Name field. This will be the name of the 3D survey that is 
created in the OpenWorks project you chose as the Destination Project earlier. 

b. Create the target 3D SeisWorks project. In the Target Seismic Project column, enter a 
unique eight character name for the 3D project. Use the Show existing 3D projects button to 
display a list of existing SeisWorks project. Click OK in the Seismic Project selection dialog 
box to save your 3D Seismic target information.

5. Submit the copy job.
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Interpretation

Within the Interpretation tab you can select to 
copy Horizons and Faults.

Copy rules and known issues associated with 
Interpretation data are:

• Not possible to copy just the Horizon 
feature. The DataSelector's Horizon tab is 
really the HorizonGrid2d representation. 
Selecting a Horizon row will copy the 
associated Horizon feature and all properties that exist for the horizon representation. 

• Only Fault Polylines can be copied. In the DataSelector's Fault tab, check the Type field. The 
Type field must say PolylineSet, Origin field must say 3d survey, and the Origin Name field 
must be a 3D survey. An easier way to filter only Fault Polylines in the DataSelector, is to click 
on the DataSelector View -> General Preferences and in the General Preferences dialog, turn 
on the Fault Polylines tab.

• It is not possible to copy just the GeologicFault feature. The DataSelector's Fault tab is really 
the FaultPolylineSet representation. The 3D survey isn't shown in the DataSelector because a 
FaultPolylineSet can span multiple surveys, it doesn't have to be associated to just one survey. 
Selecting a Fault row will copy the associated GeologicFault feature and all the polylines 
associated between compatible source and destination surveys. 

• There is no selection of the destination EarthModel and 3D survey if copying to SeisWorks 
project since there is only one model and one survey.

Submit Copy Job 

If desired, continue to select the data you want to copy in the 
DataSelector. Once you are finished selecting data, submit the 

copy job by selecting the  icon in the tool bar. Select Yes to 
start the copy job. You will then be asked where you want to 
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save the copy job definition.

A dialog will be displayed as the DataSelector tabs are 
scanned for selected data and the copy job criteria is applied. 

Task Controller 

To monitor the status of 
the copy job, display the 
Task Controller dialog.

The status of the copy 
job will update 
automatically until it is 
finished. You can also 
stop the copy job and 
view the log file.

Open an existing 
copy job

Open a previously saved copy job by selecting File -> Open. This will graphically present the tabs 
with the same information as when it was saved.

Running From the Command Line

The Copy Manager is capable of running copy jobs directly from the command line, or as part of a 
scheduled batch process. A parameter file, created with the Data Selector and Copy Manager, 
controls the copy job.
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Using the Data Selector choose the data you want to copy, this procedure is described in an earlier 
section. Open the Copy Manager and setup the copy job (e.g. target project and desired data types). 
Save (File>Save As) the Data Selector configuration into an xml file, for instance mycopy.xml. 
Create and/or edit a script to run the copy job in batch.

An example script (copy.sh) on UNIX would look like:

#!/usr/bin/sh -x

OSP_HOME=/prod/spirit/v311_86

export OSP_HOME

# copy part

$OSP_HOME/bin/runBatchCopy.sh ./mycopy.xml

$OSP_HOME/bin/runBatchCopy.sh ./mycopy2.xml

exit

Note you can have as many copy jobs as you like in the same batch file.
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Using the Well Viewer

The Well Viewer is a utility that allows users to view selected well logs and well markers in a 
conventional well track format. The Well Viewer is started from the Tools menu and requires a 
session to communicate with other applications.

When launched, the Well Viewer shows an empty 
Well Bore folder.

There are two ways to get Well Bores. The first 
method is to listen for Well Bore selection events, 
which can be made from the DataSelector, 3D 
Viewer, Arcview Extension, any native 
OpenWorks or GeoFrame application via the OpenSpirit Event Gateway or any OpenSpirit enabled 
application that sends wellbore events.

Or you can select the File -> Read Bores from Well 
List(s) menu item and then select a Well Bore List from 
the dialog. All well bore lists from the projects in your 
session will be displayed for you to choose from. 

Once you make a selection of the 
Wells you would like to view, the Well Viewer list 
shows a listing of the COMMON WELL NAME or the 
WELL UWI and the associated Logs and Picks. You 
can drill down into each well and see the Well Logs and 
Picks within each Well Bore.
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Displaying Logs and Markers

Well Logs and Picks can be dragged onto the 
active track. You can set a track to be active by 
clicking on it (it is shaded when selected). Any 
number of logs and markers may be displayed in 
a single track

Additional Well Viewer Features

The Well Viewer has additional features such as changing log display properties, depth scales, track 
display properties, adding/deleting tracks, and removing displayed objects. These features can be 
selected in the Edit menu or by icons across the top of the well display window.

Editing Markers and Logs

In order to demonstrate how OpenSpirit handles data change events, this 
viewer allows users to make simple edits to markers (drag a marker up 
and down) and logs (edit log samples). To enter Edit Mode, select the 
Selection > Editing menu item. Return to normal mode by selecting the 
Selection > Picking menu item. 

After entering editing mode, any marker may be selected and it 
will then be displayed with handles that indicate that it may be 
moved up and down the track. 

If a log is selected, all its points will be highlighted and individual 
points may be moved left/right.

Usage Note: An 
artificial wellbore 
list is always 

created for each project 
called “ALL BORES”. 
This folder contains all 
wellbores from this 
project and allows for 
the selection of 
wellbores that may not 
be in any defined 
wellbore list.
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Discarding or Committing Data Edits

As markers or logs are being edited, no data changes are stored back to the vendor project(s) unless 

the save icon is pressed and you have write access to the associated project. 

If you want to restore the data from the data store and discard any uncommitted data then the reload 

icon may be pressed. 

Listening for Data Change and Object Selection Events

If the same data object (well log or pick) is displayed in more than one track, or any 
other OpenSpirit enabled application using the same session, then these views may 
all share dynamic data changes (even between applications running on Windows and 
UNIX). To enable the Well Viewer to listen for data change events and cause it to 
automatically re-display any changed data, the OpenSpirit logo icon should be 
pressed. When listening is enabled, a yellow lightening bolt will be displayed. 
Listening may be toggled on and off by pressing the OpenSpirit logo icon.

The lightening bolt also controls the WellViewer’s response to relevant selection events. If the 
viewer is enabled for listening and it receives a selection event that contains Well Log or Well Pick 
selections, the viewer will display the selected objects in the current active track and add, if required, 
the selected Well Bore List. Note that this allows for the display of objects that may not be in the 
current Session (e.g. storeless objects created by other applications that may not be stored in 
GeoFrame or OpenWorks).

Broadcasting Object Selection Events

A selection event may be sent by highlighting a well pick or log and clicking on the 
selection broadcast icon. Sending a selection event will cause other “listening” 
applications in the same OpenSpirit session to react and display, or otherwise use, this 
selected object.

Storing/Restoring Viewer Session Information

When you exit the Well Viewer (File > Exit), you are prompted if you wish to store the track layout 
preferences. If you answer yes then the definition of how many tracks and their contents (the logs 
and picks) are saved. When you run Well Viewer at a later date, with the same OpenSpirit session, 
you are prompted whether you wish to restore the track layout preferences. If you answer yes then 
the same logs and picks are re-displayed in the designated tracks. The display colors of the logs and 
markers are also restored. Note that other display settings (e.g. depth scale) are not currently saved.

On

Off
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Using the Section Viewer

The Section Viewer is a utility that allows users to view selected inlines and crosslines from 3D 
seismic volumes, 2D seismic datasets, horizons, and faults. Multiple seismic sections representing 
different seismic attributes can be overlaid. The seismic data can be displayed in a variety of ways 
that includes variable density with a color map or wiggle variable area. The Section Viewer is started 
by selecting it from the Tools menu.

Listening for 3D Volume & 2D Seismic Selection Events

The Section Viewer has been designed for use in conjunction with another data selection application, 
such as the DataSelector. Make sure that the Section Viewer is enabled to listen to OpenSpirit events 
(the lightening bolt should be visible on the OpenSpirit logo) and then select one or more seismic 
volumes from the DataSelector. As soon as the selection event is sent the 2D or 3D volume(s) should 
appear in the 2D or 3D Volume folder in the Section Viewer. 

Displaying Seismic Sections

To display an inline or crossline section, double click on the desired volume in the 3D Volume folder 
then select, in the section selection dialog window, whether you want an inline or crossline view. 
Adjust the slider bar or type in the section number to select a particular section.

Similarly, to display the 2D dataset, double click and select it. If there is no slider for 2D data, the 
viewer will display the Seismic data for the whole set.

Usage Note: The 
Section Viewer 
ignores slice 

volume selection events.
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Displaying Horizons and Faults

If a seismic section is displayed and the viewer is enabled for listening (the lightening bolt is visible 
on the OpenSpirit logo), then the viewer will respond to any fault or horizon selection event by 
displaying the selected horizon and fault on the section and adding the name(s) to the display list 
folder.
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Note that only Horizons that are associated with the same seismic 2D or 3D survey will be 
displayed; any other selection events will be ignored. Also, the viewer does not display intersecting 
faults – only those faults drawn in the selected inline/crossline are displayed. If the displayed inline 
and crossline are advanced to another line (via the toolbar icons, menu item, or by double clicking 
on the seismic volume in the display list), then the horizon and fault overlays are automatically 
updated. Display of individual horizons or faults may be toggled on/off by double clicking on the 
switch icon to the left of the horizon/fault name in the display list.
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Cursor Tracking

You can send or receive OpenSpirit 3D cursor locations by toggling the cursor tracking icons on 
and off. This sharing of cursor location information will work between any number of OpenSpirit 
enabled applications, running anywhere on the network that are tied into the same OpenSpirit ses-
sion. This shared cursor tracking will also work with Landmark applications (e.g. SeisWorks) if an 
OpenWorks Event Gateway is running that ties the current OpenSpirit session to the OpenWorks 
session.
This figure illustrates the Section Viewer sending cursor location events. 

Additional Section Viewer Features

You can change display attributes, display types, change between inline and crossline, change color 
maps, display section overlays, scroll through the volume, and zoom in and out by selecting the 
various menus or icons at the top of the section display.
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Using the 3D Viewer

The OpenSpirit 3D Viewer provides a basic functionality that allows the user to visualize most of 
the OpenSpirit Subsurface data objects, which include the following: Wells, Wellbores, Well Logs, 
Well Picks, 3D Seismic Volumes, 2D Seismic Datasets, Horizons, Horizon Properties, and Faults.

This viewer also allows the user to send and receive OpenSpirit cursor location events as well as to 
send object selection events.

The OpenSpirit 3D Viewer is a cross platform viewer that demonstrates interoperability using cursor 
tracking and selection events. It provides the ability to view all of the different data types that are 
supported in the OpenSpirit Framework.

Usage Note:

The OpenSpirit 3D 
Viewer can be run 

on Solaris, Windows, or 
Linux (provided the 
desktop computer has the 
appropriate OpenGL 
libraries (v1.1 or 
greater) installed. 
Windows comes with 
OpenGL pre-installed 
but it may be necessary 
to install OpenGL 
libraries on your Solaris 
workstation. The 
performance of the 3D 
viewer will be highly 
dependant on the type of 
graphics card that you 
are using.
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Connect to an OpenSpirit Session

The 3D Viewer should be launched from the OpenSpirit Launcher after setting the current session. 
To connect to the OpenSpirit Session click on the OpenSpirit logo on the 3D Viewer toolbar.

A dialog will be displayed allowing you to assert what coordinate system you wish to use for the 
current 3D Viewer. You can choose whether to display objects in the time or depth domain. The 
OpenSpirit data connectors will convert the well path, log, and pick information into the time 
domain as long as there is a preferred time-depth table (check shot) for that well in the source 
database. OpenSpirit will NOT perform on the fly time-depth conversions for seismic, horizon, or 
fault data. In addition to specifying the desired domain, you must also specify what coordinate 
system you wish to use. As data in your OpenSpirit Session can be coming from a variety of vendor 
projects and can be stored in different coordinate systems, you must specify which common 
coordinate system OpenSpirit should use. If you have set a preferred coordinate system on the 
OpenSpirit Session then you can choose to use this (if no preferences were set then these options 
will be grayed out). You can also choose to use the preferred coordinate system of any project in your 
session. In this illustration, we chose to use the coordinate system used by the OpenWorks FIELDA 
project.

After you have successfully selected a coordinate system and connected to the OpenSpirit Session, 
the current session’s name will appear in the title bar and the OpenSpirit logo will have the lightening 
bolt turned on, as illustrated below, indicating that you are ready to receive OpenSpirit events.

Select Objects for Viewing

The 3D Viewer can send and listen for OpenSpirit selection events. These events can be generated 
by other OpenSpirit Viewers, the OpenSpirit DataSelector, or third party OpenSpirit enabled 
applications. Users can even receive events from native GeoFrame or OpenWorks applications 
(provided the appropriate OpenSpirit Event Gateway is running). In this illustration, the 
DataSelector has been used to broadcast a selection events, which are then displayed in the 3D 
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viewer.
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Manipulate the 3D View

Action Function

Rotation Hold the left mouse button down and move the mouse to rotate about 
the center of the viewing scene.

Zoom Hold the middle mouse button (or scrolling wheel) down and move 
the mouse up and down to zoom in and out.

Translation Hold down the right mouse button and move the mouse up and down 
to move the viewing window. 

View Vertical Stretch - By default, the viewer displays the 3D scene with 
no vertical exaggeration (horizontal display scale equal to vertical 
display scale). When a display is in the time domain, a pseudo 
vertical exaggeration is calculated using a constant velocity of 
10,000 ft./sec.
Background Color - Changes the background color
Horizon Depopulation - Shows a subset of the horizon data. Useful 
when working with large horizon data sets that take a very long time 
to load and display.
QuickMovie - Select this option to change to a “wire frame” view 
when rotating or zooming the view. Useful when working with large 
datasets.
Stereo - View in stereo mode if supported by hardware.

Re-Center View Use the icon on the Toolbar to re-center the view to its “home” 
position with all the displayed objects visible and in the center of the 
view. This is quite helpful when you get “lost” in exploring the 3D 
scene.

Lighting Model Use the icon on the Toolbar to add and remove directional lights. 
This can be used effectively to accentuate faulting patterns on 
surfaces.

Axis Display Use the icon on the Toolbar to add and remove the 3D axis and 
labels.

Background Color Use the icon on the Toolbar to change the background color.
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Performance Trade-offs

The display of shaded horizons takes a lot of graphics processing power and you may find that 
moving around a 3D scene with horizons is very sluggish. One option is to enable the QuickView 
mode (from the View menu), which will convert the 3D scene to a wire frame display while the 
mouse is moving and then restore the scene to a full display when the desired viewing position is 
found. The other is to use the Horizon Depopulation option, also from the View menu, that will thin 
the horizon data set for display purposes only.

While adding many wellbores and picks to your display in a single selection event, you might prefer 
to turn off the Progressive Add option (from the Display menu). When Progressive Add is enabled 
while object selection events are received, each object is individually displayed as its data is 
received. With Progressive Add disabled, the viewer delays display of the objects until all the object 
data for all objects in the selection has been received. This minimizes the overall elapsed time but 
does not give you any visible signs of progress. 

Use a Selected Object

When the selection icon is in selection mode,  an object can be selected by clicking on it. 

When selected, the object’s border will turn red and three Toolbar icons will become enabled.

Display/Edit Object Properties

Use the icon to display properties of the highlighted object. The display preferences can be set 

through a dialog box, which will be displayed. An alternative means of opening a highlighted 
object’s property dialog is to double click on the selected object.

Clipping Planes Use the icon on the Toolbar to set and manipulate clipping planes. 
This can be helpful to see inside of complicated structures

Perspective View Use the icon on the Toolbar to toggle between perspective view (the 
startup default) and parallel view.

Save/Print Screen Images A jpeg image file of the current 3D scene can be saved to disk by 
clicking the icon or sent to the default printer by pressing the icon.

Action Function

Usage Note:

All object property 
dialogs have 

a“Reload Data” button 
that will force the data to 
be re-read from the 
underlying datastore.
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Well

The preferred color and size for the well derrick symbols can be chosen and applied to all wells.

Wellbore

The preferred color and line style for the wellbore path can be chosen and applied to all wellbores.

Well Log

The preferred color, line style, and azimuth can be chosen for the highlighted log.

Note: If multiple logs are displayed for the same wellbore it is quite helpful to display them at 
different azimuths to avoid overlapping log curves.

Well Pick

The preferred display size (radius) of the pick can be chosen and applied to all well picks. The color 
of the pick is determined by the value of an attribute in the datastore.

Seismic 3D Volume

The Seismic property dialog allows the user to select which inline, crossline, or horizontal slice is 
displayed. The user can also access the color bar editor to change the color map used to display 
seismic (color maps can also be stored and restored to and from disk). The minimum and maximum 
seismic amplitude values can also be set to control the amplitude range that is mapped to the chosen 
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color map.

Seismic 2D Dataset

Seismic 2D datasets are similar to displaying the Seismic 3D volume. However, there is no slider or 
bounding box because a 2D dataset only resides on a particular line. The property box supports color 

Usage Note:

It can be very slow 
to display 

horizontal slices from 
trace oriented data and 
vice versa. If your 
seismic project has 
multiple sort orders of 
the same data, it would 
be best to select and 
display multiple seismic 
volumes in the 3D Viewer 
and only display the 
preferred direction from 
each volume
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map and min/max amplitude.

Horizon (and Properties)

The Horizon property dialog allows the user to select a single horizon property to be draped on the 
Horizon surface and displayed with a pseudo color map. Users can also access the color bar editor 
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to change the used color map.

Faults

The preferred color and line style for the fault vectors can be chosen and applied to all faults.

Remove Object from Display

Use the icon to remove the highlighted object from the 3D Viewer display. Note that the 

object is not removed from its datastore and can be redisplayed by sending the 3D viewer an 
OpenSpirit Object Selection event referencing the removed object. 
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If you wish to remove all objects of a certain type then it is easier to use the 
appropriate menu item from the Display menu.

Send Object Selection Event

Use the icon to send an OpenSpirit Object Selection event containing a 

reference to the highlighted object.

Send and Receive Cursor Location Events

Use the  icon to send the 3D cursor location. The position of the 3D cursor is controlled by 

the sliders in the 3D Cursor control dialog box, as illustrated below:
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To ensure that the cursor location is snapped to a position on an object, toggle the  icon to its 

Point Broadcast state and then click on an object, as illustrated below. This x,y,z location on 

the object will be broadcast as an OpenSpirit Cursor Location event as well as a Point of Interest 
Event.

To receive OpenSpirit cursor location events click on the  icon. Cursor location events can 

be generated in another OpenSpirit Viewer, a third party OpenSpirit enabled application, or even 
native GeoFrame or OpenWorks applications (provided the appropriate OpenSpirit Event Gateway 
is running).



66



67

Using the Scan Utility

Overview

The OpenSpirit Scan Utility is an optional, add-on product to the OpenSpirit Subsurface Data 
Module that runs from a graphical user interface, or in batch file mode. This utility allows users to 
scan all or selected projects in an OpenSpirit supported data store and output the following GIS 
layers in ESRI Shapefile format (.shp, .shx, .prj, .dbf), or optionally to an ESRI ArcSDE 8.x (or 
newer) database:

After these features are generated with the OpenSpirit Scan Utility, they can then be viewed in 
ESRI's GIS products or any GIS product that can read standard ESRI shapefile formats, or from a 
SDE database. The Scan Utility can also be used in conjunction with the OpenSpirit ESRI ArcMap 
Extension to allow ArcMap to be used as an OpenSpirit enabled DataSelector. When used with 
OpenSpirit’s data viewers, or other OpenSpirit enabled vendor applications, these utilities give users 
a rich set of tools for browsing data from a variety of project data stores. 

The Scan Utility can be run on Windows, or UNIX via a simple user interface, or through a 
command line interface suitable for submission as an automated batch process. 

Project Data Outlines (Seismic and Well)

Well Surface Locations

Well Bottom Hole Locations

Wellbore Paths

3D Seismic Survey Outlines

3D Seismic Volume Outlines

3D Seismic Live Trace Coverage

2D Seismic Line Locations

2D Seismic Dataset Locations

Horizon and Volume Catalogs - .dbf or SDE table containing a list of all interpreted time or depth 
horizons and separate .dbf file, or SDE table, for volumes contained in a 3D seismic survey
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Example of output shapes generated by the OpenSpirit Scan 
Utility as displayed in ESRI ArcMap:

Installation and Starting the Scan Utility

The OpenSpirit Scan Utility is installed as part of the normal OpenSpirit installations. In order to run 
this utility, however, you must obtain a valid license. The SDE capability is licensed separately. 
Evaluation license keys can be obtained by sending an email request to support@openspirit.com.

Usage Note:

You can also run 
the Scan Utility 

from the command line. 
On Windows run 
scanutility.bat and on 
UNIX run scanutility 
located in the 
$OSP_HOME/bin 
directory. This makes it 
easy to run multiple jobs 
in batch mode once you 
have set all the 
parameters. See the 
section Running from 
the Command Line for 
more details
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Running the Scan Utility in Shapefile Mode

The Scan Utility can be started in GUI (Graphical User Interface) mode from the OpenSpirit 
Launcher menu under Tools -> Scan Utility, or in command line mode. It does not require a session. 
In GUI mode, the definition of the scan job can be saved as an .xml definition file for later use, or 
for submission in batch file mode. If the Scan Utility is rerun on the same data store, and into the 
same target directory, it will incrementally update existing shape files. The SDE enabled ScanUtility 
has a slightly different appearance, and will be described in the proceeding section Running the Scan 
Utility in SDE Mode.

Setting General Options

If you have both SDE and Shape file 
Scan Utility licenses, you will see an 
Output line with Shape files, and SDE 
database. Select the Shape files radio 
button. If you only have a Shape files 
license, then the Output line will not 
be visible, and you can only scan in 
shape file mode.

In the Target Directory field, select the 
output directory by using the Browse 
button and navigating the file 
hierarchy to select the desired 
directory. You must insure that you 
have write permissions to this 
directory. The target directory you 
choose will contain all generated 
shape files, including a log file. A 
directory is selected by double 
clicking on its name and then selecting 
the OK button. Select the project for 
scanning from the Source Datastore 
drop-down menu. The generated 
shape file names are prefixed by the 
data store name selected.

Select the projects within the data 
store to scan. You can scan all 
projects, or a subset of selected 
projects. The choice is made on the 
Projects line by clicking on the 
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corresponding radio button. 

If the Selected Projects radio button is checked, click on the Select button and the select projects 
dialog is displayed, showing all the projects in the selected data source.

Initially, this dialog will have no projects in the 
Selected list. To move projects from one list to the 
other, click on the project and then click the single 
arrow button to move it to the desired list. All 
projects can be moved to, or removed from, the 
Selected side by using the double arrow buttons.

Only the projects a user has access to are displayed 
in the Available list. Even if the All Project option 
is selected, OpenSpirit utilizes the access control 
mechanism of the underlying data store and will 
only scan those projects the user’s ID has access to. 

You can check and update passwords by selecting 
the Password button. OpenSpirit utilizes the access 
control mechanism of the underlying data store and 
because these vary, OpenSpirit’s behavior varies 
correspondingly. Enter project passwords, if 
required, if you have not already entered the 

passwords elsewhere.

The Set Password for Projects dialog box shows the user's project password (shown in asterisks) if 
the data store type requires password information and it has been entered earlier. If the data store 
type requires account and password information then account and password columns are shown. If 
the Password field is blank, provide the required password. When all passwords are provided, click 
OK.

In the Scan Utility Output coordinate system area, set the desired output geographic coordinate 
system to Predefined or Reference Project. All output shapes are converted to a consistent 
geographic latitude/longitude coordinate system that is defined here. You can choose to use a well-
known geographic coordinate system, such as WGS 84, by clicking on the Predefined radio button, 
and then select the datum from the associated pull-down menu. Click on the Reference Project radio 
button if you want to use one of your project’s projection system (the project's preferred display 
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geodetic datum and ellipsoid). The geographic system of this project is used as a reference while 
writing the shape files. All the objects in different projects are converted to the one preferred 
geographic system selected here as they are written to the shape file. 

The Scan Utility outputs the shape files and SDE layers in the consistent, unprojected, latitude/
longitude system chosen in either the Predefined, or Reference Project field. It is up to the GIS 
viewer, such as ArcMap, to a map the data in a projected system. An ESRI .prj file is produced for 
each shape file when a well know datum is selected and it is available as an ESRI defined datum. 
This .prj file contains datum information so ArcGIS 8.2+ can perform on-the-fly datum shifts and 
map projections.

Select Output Options

Select the desired output by checking the appropriate generation options in the Output Features 
section of the Scan Utility GUI. Each option is described in the table below.

Project Extent

Seismic Project Extent: The four corner points of each project scanned, containing the 
geographical extent of seismic data in the project.

Well Project Extent: The four corner points of each project scanned, containing the geographical 
extent of well bore data in the project.

3D Seismic

3D Surveys: The four corner points of scanned 3d surveys along with key attributes.

3D Volumes: The four corner points of scanned volumes with key attributes.

Live Trace Coverage: An irregular multipart-polygon outline of the lines in a volume with trace 
values other than 0 taken at a time-slice half way through the volume. 

Tolerance Threshold: Controls the detail of the line geometry in the Live Trace Coverage 
polygons. It is a number that represents the perimeter (in traces) of the smallest hole to preserve. A 
tolerance of less than 10 means the line geometry is represented by the minimum number of traces 
required to preserve the details of the original line geometry to within a tolerance of 10. A tolerance 
threshold of 0 produces no decimation.

Slice Volumes Only: All slice-oriented volumes are scanned, and a live trace coverage polygon 
generated for each slice volume. Generating live trace coverages for slice volumes is very quick and 
does not take much time. This is the recommended setting for the first pass of the Scan Utility in a 
new project.

Usage Note: DO 
NOT select All 
Volumes in Live 

Trace Outline unless 
you know what is in 
the seismic project! 
The Live Trace 
Outline scan process 
must have a slice 
volume to generate the 
polygon representing 
the live traces. If a 
large volume 
(thousands of lines) is 
trace-oriented, it can 
take several hours to 
generate a time-slice 
for each volume. It is 
highly recommended 
to scan all slice 
volumes and then use 
the Selected Volumes 
option to pick the 
trace volumes you 
wish to scan in a 
second run.
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All Volumes: This option will generate live trace coverages for all trace and slice volumes in a 
project. NOTE: Generating live trace coverage from large, trace oriented volumes can be very time 
consuming. The live trace coverage calculation must extract a horizontal slice from the midpoint of 
each trace oriented volume, and this will be very slow for large volumes. Use with caution.

Selected Volumes: This option is only available if the Scan Utility is being run a second time to 
update a set of shape files or SDE scan sets, and a 3D Volume Shape files already exist. You have 
to scan the project a second time, in the same directory in shape file mode, so the .dbf volume 
catalog can be read. In this case you can manually select which volumes are to be scanned for live 
trace coverage by clicking on the Select button. The project must be scanned a second time for the 
selected volumes to be generated.

2D Seismic

2D Lines: The line geometry, including SP numbering as a shape measure, will be output to a line 
feature along with key attributes. This option produces a line coverage representing 2D “nav” data.

2D Datasets: The line geometry for the dataset, including SP numbering as a shape measure, will 
be output to line feature along with key attributes. This produces a line coverage representing a 2D 
line with "nav" data and trace data. Only header files/data base entries are checked, so this is much 
faster than LiveTrace Coverage.

Tolerance: Controls the detail of the line geometry that is written out to the shape file. A tolerance 
of 10m means the line geometry will be represented by the minimum number of points required to 
preserve the details of the original line geometry (thinned) to within a tolerance of 10m. A tolerance 
of 0 produces no decimation.

Live Trace Coverage: This option produces a polyline representing areas along a 2D line that have 
"live" 2D data. OpenSpirit opens each 2D data file and access every trace along a 2D line. A line 
segment is created when there is no null, or nonzero traces. This option can be time consuming 
because traces from every 2d data file associated with a line are opened and read.

Tolerance gap threshold: The number of null, or zero value traces that will produce a gap in a 2D 
line when the Live Trace Coverage option is selected.

All Datasets: This option will generate a Live Trace Coverage for all 2d lines and all 2d datasets. 
NOTE: Generating live trace coverage for all lines in a project with many datasets can take a large 
amount of time.

Selected Datasets: This option is only available if the ScanUtility is run a second time to update a 
set of shapefiles, or SDE scansets, and a 2D Lines and 2D Datasets coverage already exists. In this 
case you can manually select 2d lines to scan by clicking on the Select button. The project must be 
scanned a second time to generate a coverage for the selected line.

Interpretation
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Set the run options

Review the settings under the Options menu. 

There are several run options to consider which are summarized below.

Start the scan job

Click the Run button on the toolbar or under the Run menu to launch the batch process.The Progress 
Window displays the status and progress of the scan process and progress information will be written 

Horizon Catalog: A dbf file, or SDE table, will be created that contains a catalog listing of all time 
and depth horizon representations associated with the scanned seismic projects.

Grid 2d: A dbf file, or SDE table, only is created containing a catalog listing of non-seismic two 
dimensional grid representations.

Wells

Well Surface Location: The surface location of the scanned wells along with key attributes 
represented as a point feature.

Well Bottom Hole Location: The location of the bottom of the scanned well bore along with key 
attributes represented as a point feature.

WellBore Path: The 3D wellbore path, along with MD as its measure, represented as a line feature 
along with key attributes. The deviated survey is used if available. If only the top and bottom hole 
location is available, then a two point well bore path is made.

Tolerance: This controls the detail of the wellbore geometry that is written out to the shape file. A 
tolerance of 10m means the wellbore geometry will be represented by the minimum number of 
points required to preserve the details of the original wellbore geometry to within a tolerance of 10m. 
A tolerance of 0 produces no decimation.

Shutdown Servers After Use: Check this option if you want data connectors to be shutdown after 
the scan process is complete. Unless you are running other OpenSpirit client applications under the 
same userid that has launched the Scan Utility, this should be selected. In this case, the selection 
can be cleared to prevent the Scan Utility from shutting down a data connector that can be in use.

Remove Deleted Projects: Check this option if you are updating existing shape files and are 
scanning all projects and wish to remove shapes from projects deleted from the data store.

Use Tabs for Features: Makes all Scan Utility output features accessible by tabs. Considerably 
shortens the Scan Utility window, and lessens the amount of room it takes on screen (see below).

Usage Note:

A master .dbf file is 
created for a data 

store when it is scanned. 
Its name is automatically 
set to 
datastorename_master.d
bf. This master .dbf file 
contains information 
about the geographic 
coordinate system used 
for the OpenSpirit shape 
files.
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a log file in the Target Directory. 

Running from the Command Line

The Scan Utility is capable of running in Shapefile or SDE mode directly from the command line, 
or as part of a scheduled batch process. A parameter file, created with the Scan Utility GUI, controls 
the scan job.

Use the Scan Utility GUI as described in the earlier section to define a scan job and save it as an xml 
control file. The File Menu in the Scan Utility menu bar provides several options to save and edit 
the xml control file. The table below lists the Options to save a ScanUtility parameter file from the 
Scan Utility GUI.

After you have a defined scan job .xml control file, start the ScanUtility directly from a DOS shell 
or UNIX xterm. Type scanutility in Unix, or scanutility.bat in Windows, with a quoted ScanUtility 
parameter file (including its .xml extension). This assumes that these commands are in your path, or 
you are in the $OSP_HOME/bin directory. The GUI for the Scan Utility will start if the .xml 
parameter file is omitted.

The following is an example of starting the ScanUtility from the UNIX command line, in the 
OpenSpirit installation directory, bin subdirectory, using the xml parameter file scan_all.xml 
generated earlier with the ScanUtility GUI, in shapefile mode:

scanutility "/users/jep/scan_jobs/scan_all.xml"

If you want to run in SDE mode from the command line, you have to use the -OpenSpiritSDE option. 
Additionally, all of the SDE parameters described in the "Running the Scan Utility in SDE Mode" 
section below must be in the .xml control file. Lastly, you must also have an additional OpenSpirit 
SDE Scan license. The same batch scanjob in SDE mode looks like:

scanutility -OpenSpiritSDE "/users/jep/scan_jobs/scan_all.xml"

Menu Items Action

File > Save User is prompted to enter a file name. This option saves the input 
parameters on the GUI as a text file with an extension.xml

File > Save As User is prompted to enter a file name. This option saves the current .xml 
file as a new, different .xml file

File > Open User is prompted to select a .xml file. The input values from the selected 
script file are read and the GUI is populated with them.

File > Clear All the GUI elements are cleared and initialized.

Usage Note:

When running in 
batch mode you 

should first make sure 
that the project 
passwords, if required by 
the selected data source, 
are properly set, and 
your user server is 
running. Having entered 
these passwords once for 
a given userid, 
OpenSpirit persists these 
passwords in a secure 
fashion, so they do not 
need to be reentered.
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On a Windows system, the same SDE job will look like:

scanutilty.bat -OpenSpiritSDE "C:\Documents and Settings\jep\scan_jobs\scan_all.xml"

Check the logs in the Target Directory when the scan job is complete for job status, and any errors 
encountered by the Scan Utility.
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Shapefile File Naming Conventions

The following files can be generated in the selected output directory when scanning in Shapefile 
mode (italics represent name components that are data dependent):

Shapefile Filename Contents

datastorename.log log file containing details of run that generated 
shape files

datastorename_master.dbf
datastorename_datastore.dbf

“master” .dbf file that contains information about 
coordinate system used for OpenSpirit shape file 
generation, and “datastore” .dbf information on the 
scanned datastore

datastorename_project.shp
datastorename_project.shx
datastorename_project.prj
datastorename_project.dbf

polygon shapes representing project extents of 
scanned projects from data store for both wells and 
seismic

datastorename_well.shp
datastorename_well.shx
datastorename_well.prj
datastorename_well.dbf

point shapes representing surface locations of wells 
in scanned projects from data store

datastorename_wellBottom.shp
datastorename_wellBottom.shx
datastorename_wellBottom.prj
datastorename_wellBottom.dbf

point shapes representing bottom hole locations of 
wells in scanned projects from data store

datastorename_wellPath.shp
datastorename_wellPath.shx
datastorename_wellPath.prj
datastorename_wellPath.dbf

polyline 3D shapes representing the wellbore paths 
of wells in scanned projects from data store

datastorename_sur.shp
datastorename_sur.shx
datastorename_sur.prj
datastorename_sur.dbf

polygon shapes representing outlines of 3D seismic 
surveys of scanned projects in the data store

datastorename_vol.shp
datastorename_ vol.shx
datastorename_ vol.prj
datastorename_ vol.dbf

polygon shapes representing outlines of 3D seismic 
volumes from surveys of scanned projects from 
data store

Usage Note:

OpenSpirit runs a 
separate data 

connector for each 
seismic project, so it is 
advisable to shut down 
connectors if many 
seismic projects are 
being scanned to make 
more efficient use of 
system resources.
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datastorename_trccov.shp
datastorename_ trccov.shx
datastorename_ trccov.prj
datastorename_ trccov.dbf

polygon shapes representing outlines of live trace 
coverage within selected volumes of seismic 
surveys of scanned projects from data store

datastorename_ln2.shp
datastorename_ln2.shx
datastorename_ ln2.prj
datastorename_ln2.dbf

polyline shapes representing location of 2d seismic 
lines of scanned projects from data store. The 
density of points along the line is determined by the 
tolerance factor

datastorename_ps2.shp
datastorename_ps2.shx
datastorename_ ps2.prj
datastorename_ps2.dbf

Polyline shapes representing location of 2D seismic 
datasets of scanned projects from data store. The 
density of points along the line is determined by the 
tolerance factor

datastorename_ horz.dbf Horizon catalog file containing entries for all time 
and depth horizons for interpreted horizons from 3D 
seismic surveys of scanned projects from data store 

datastorename_grid2d.dbf Two dimensional grid catalog file containing entries 
for all non-seismic two dimensional grids.

Shapefile Filename Contents
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Running the Scan Utility in SDE Mode

When an OpenSpirit SDE Scan 
license feature is available, an 
Output line is added to the Scan 
Utility enabling the user to select 
either Shape file mode, or SDE 
database mode giving the 
ScanUtility a slightly different 
appearance. If Shape files is selected 
as the output option, then the Scan 
Utility will behave exactly as 
described in the previous section, 
Running the Scan Utility in 
Shapefile Mode.

Selecting SDE database on the 
Output line puts the Scan Utility in 
SDE mode. In SDE mode, the Scan 
Utility stores the GIS features in an 
ESRI ArcSDE 8.x or 9.x enabled 
database, instead of files described 
earlier. Before you can use the Scan 
Utility, you must have a SDE 
account with the proper roles and 
privileges.

SDE Roles and Privileges

The user must have certain privileges within the SDE database in order to run the Scan Utility in 
SDE mode. These roles and privileges are defined by the SDE Administrator. Before you start 
scanning into SDE, you should discuss a strategy with your SDE Administrator. Each Scan Set is a 
group of tables that maintain attribute information on the GIS objects created by the OpenSpirit Scan 
Utility and are “owned” by the account that creates them. Permissions and roles for users must be 
set up correctly inside of SDE for the Scan Utility to function Properly.

See the ESRI documentation, “ArcSDE Configuration and Tuning Guide for Oracle” on how to 
create SDE roles. It is available on your SDE installation disk. Additional information on SDE 
configuration and tuning can be found at www.esri.com. 

OpenSpirit Scan Set Tables

GIS coverages (2d lines, survey polygons, well points, etc.) are stored in tables within the database 
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running SDE and are organized into Scan Sets. They are owned by the SDE account used to create 
the Scan Set and stored under the SDE account’s schema, in its default tablespace. Other users will 
have to be granted at least select on these tables, after they have been created, in order to use them 
in ArcMap.

OpenSpirit places only one table, SCAN_SET_INFO, in the SDE administrator schema. This table 
is created the first time the Scan Utility is run and contains a central catalog of scan sets. No other 
tables are created, or maintained in the SDE account unless the ScanUtility is run using the SDE 
master account, or it is set up to do so by the SDE administrator. Each SDE user that will create, and 
manage OpenSpirit SDE scan sets must have DELETE, INSERT, SELECT, and UPDATE privileges 
on the SCAN_SET_INFO table. Your SDE, or database administrator will have to grant you this 
access before you SDE account can create OpenSpirit scansets with the ScanUtility.

SDE Scan Set Table 
Name

 Contents

scansetname$MASTER “master” table storing information about coordinate 
system used for OpenSpirit Scan Set generation

scansetname$DATA_STORE maintains information about the scan set’s datastores

scansetname$PROJ_EXTENT polygons representing well and seismic data extents of 
scanned projects from data store

scansetname$WELL_BORE points and attributes representing surface locations of 
wells in scanned projects from data store

scansetname$WELL_BOTTOM points and attributes representing bottom hole locations 
of wells in scanned projects from data store

scansetname$WELL_PATH 3D polylines and attributes the wellbore paths of wells in 
scanned projects from data store

scansetname$3D_SURVEY polygons and attributes representing outlines of 3D 
seismic surveys of scanned projects in the data store

scansetname$3D_VOLUME polygons and attributes representing outlines of 3D 
seismic volumes from surveys of scanned projects in a 
data store

scansetname$3D_LIVE_TRACE polygons and attributes representing outlines of live trace 
coverage within selected volumes of seismic surveys of 
scanned projects from data store
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Starting the Scan Utility in SDE Mode

The Scan Utility dialog is started from the OpenSpirit Launcher menu under Tools -> Scan Utility, 
or in command line mode with the “-OpenSpiritSDE” option. It does not require a session. In the 
Scan Utility GUI, the SDE definition of the scan job can be saved for later use, or for submission in 
batch file mode. If the Scan Utility is rerun on the same data store, and into the same SDE Scan Set, 
it will incrementally update existing feature layers.

scansetname$2D_LINE polylines and attributes representing location of 2d 
seismic lines of scanned projects from data store.

scansetname$2D_DATA_SET polylines and attributes representing location of 2D 
seismic datasets of scanned projects from data store 

scansetname$3D_HORIZON table containing attribute entries for all time and depth 
horizons for interpreted horizons from 3D seismic surveys 
of scanned projects from data store 

scansetname$GRID_2D table containing attribute entries for grids created from 
non-seismic data
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Setting SDE Options

In the Scan Utility GUI, the first 
step it to toggle the Output to SDE 
database. This will add two lines to 
the Scan Utility GUI: SDE 
Database and Scan Set. This is 
where the SDE database connection 
is managed. Selection of the Log 
File Directory, Source Datastore, 
and Output Features are exactly the 
same as described earlier in 
Running the ScanUtility in 
Shapefile Mode. 

Connecting to SDE

Your SDE database account must 
have the ability to create data in 
SDE in order for the ScanUtility to 
work. Additionally, you must have 
INSERT, UPDATE, and DELETE 
access on the table 
SCAN_SET_INFO, created by 
OpenSpirit, inside of SDE. Contact your SDE Administrator for this access. Suggested roles are 
described earlier in the Example SDE Roles table.

On the SDE Database line click on the Connect button. This will launch the Set SDE Connection 
Parameters dialog box. You have the option to connect to the SDE Database using either the 
Default SDE Connection, or SDE Direct Connect.

Default SDE Connection

The Default SDE Connection connects to the SDE 
database through the SDE daemon. You must 
provide SDE connection information for the server 
SDE is running on. The required parameters are:.

• Server - Oracle server that is running SDE, can be 
either the server name or IP address. 

• SDE Server port - the port SDE is listening on 
(5151 is default for SDE). 

• User Name - SDE user with appropriate 
permissions to sde.scanset_info
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• Password - SDE user's account password for a SDE database user account.
Check with your SDE administrator for this information

After you are connected, the Connect button turns into a Disconnect button, and provides 
information to the SDE host and port you are connected to. Just click on the Disconnect button to 
disconnect from SDE.

SDE Direct Connect 

The SDE Direct Connect method connects 
directly to SDE’s Oracle database, thus 
bypassing the SDE daemon. The required 
parameters are:

• Database - Oracle instance containing the 
SDE installation

• Server - Oracle server that is running SDE, 
can be either the server name or IP address

• Service - sde:oracle10g, or sde:oracle9i

• Check Database Authentication or 
Operating System Authentication as 
required.

• User Name - SDE user with appropriate permissions to sde.scanset_info. See OpenSpirit User's Guide 
for details.

• Password - SDE user's password @ Oracle service. For example if the password is pass, and the Oracle 
service is sb, then enter pass@sb in the Password field.

If successful, the Scan Utility will report on the SDE Database button as Connected, and you will be 
able to manage scan sets.
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Creating SDE Scan Sets

In the OpenSpirit 
Scan Utility, if the 
SDE database is 
connected, a Manage 
button will become 
active on the Scan Set 
line. Click on the 
Manage button to 
launch the Manage 
Scan Sets utility 
window. Your SDE 
account must have 
the proper 
permissions and roles 
as described earlier in 
SDE Roles and 
Privileges to create 
and update SDE Scan 
Sets.

The first step is 
entering a Scan Set 
Name at the top of the 
dialog. Once saved, 
the Scan Set name 
cannot be changed. A 
Scan Set name is 
limited to 15 characters, must start with a letter, and can be made up of characters, numbers, and the 
symbols # and _. 

The Last Updated, Created, and Created by fields are automatically filled in. The Created by field 
shows who’s SDE account actually owns the tables that make up the SDE Scan Set.

In the Coordinate System field, set the desired output geographic coordinate system to the desired 
system. This cannot be changed once data is written to the scan set. All output to SDE will be 
converted to a consistent geographic coordinate system that is defined here. You can choose to use 
a well-known geographic coordinate system, such as WGS 84, by clicking on the down arrow, and 
then select the datum from the associated pull-down menu. 

The Scan Utility outputs the SDE layers in the consistent, unprojected, latitude-longitude system 
chosen in the Coordinate System field. It is up to the GIS viewer, such as ArcMap, to a map the data 
in a projected system. 
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If SDE Keywords are used by your SDE administrator, use the pull-down menu in the Configuration 
keyword field and select the appropriate SDE keyword for the scan job. If you do not use SDE 
keywords, or know what a SDE keyword is, leave it set to DEFAULTS.

Next, you must choose the SDE Grid Size. This is often described as more of an art, rather than a 
science. You may want to contact your SDE Administrator for advice, or ESRI at www.esri.com to 
get some ideas on what is best for your installation. Once data is written into the Scan Set, the Grid 
Size cannot be changed. Units for the Grid Size are in degrees. Where possible, specify a grid size 
where a high percentage of features fall wholly within one grid cell.

Three suggested grid sizes are provided, or you can use the Custom box to define your own in 
decimal degrees. The Small (0.01) Grid Size may be useful if your Scan Set covers a small area, such 
as a few counties. The Medium (1.0), or perhaps Custom 2.0, may be useful over a region such as 
many states, the Gulf of Mexico, or the Persian Gulf. The Large (4.0) may be useful for a world wide 
Scan Set. A grid size set too small will result in some GIS features not being able to make it into 
SDE, while one too large will make SDE run slower. Further information can be found at 
www.esri.com in the article HowTo: Tune the Multi-Level Grid Spatial Index:

http://support.esri.com/index.cfm?fa=knowledgebase.techArticles.articleShow&d=23407

A multiplier is used by SDE to convert decimal values to integers for storage in SDE. Any decimal 
left after the multiplication will be lost, so a larger xy scale means better precision. The X,Y Scale 
is calculated for you based upon the other parameters provided. It is for reference only, and cannot 
be changed by the user.

The Extent defines the area that the scan set will cover and cannot be changed once the Scan Set has 
been created and saved. Care and forethought must be taken to ensure that the parameters set for the 
output feature class match the source data. Improper spatial domain settings in the Extent box of the 
Manage Scan Sets dialog often result in the error: “... {The coordinates or measures are out of 
bounds.}...” .
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The Extent Longitude/Latitude Min/
Max must contain the area for all of the 
data you will scan now, and in the future. 
Once the scan set is saved, it cannot be 
extended. The Longitude/Latitude must 
be in decimal degrees between +180 to -
180 and +90 to -90. The Latitude range 
will not “wrap” across 180. If your 
source data includes negative Z (depth) 
coordinates, or negative M 
(measurement) the Depth/Time and 
Measurement fields must also include a 
negative range. In order to help you 
visualize the scan set’s extent, click on 
the Show Map button. This will launch a 
Map Utility that will help you pick the 
extent. In the map extent tool, click on 
the last icon on the right to go into pick 

mode, and then highlight your area of interest. The Map Utility can be dismissed by clicking on the 
close window icon in the upper right hand portion of the window. When you are satisfied with the 
Extents, click on the Apply button in the Manage Scan Sets tool. You can change the geographic 
extents of the scan sets up until you have scanned data into the scan set.

The Description field in the Manage Scan Sets tools is a free form text field where you can place 
information to describe the Scan Set.

CHAPTER 2 OpenSpirit Tutorial



86

The last step in defining a scan set 
is selecting the attributes for each 
data set. In the Manage Scan Sets 
tool, click on the Save button. This 
will launch the Configure Scan Set 
attribute window. Each tab 
represents a separate data type. 
Select the attributes you wish to 
save into the SDE database with 
your scan set. Once data is scanned 
into a data set, the selected 
attributes cannot be changed.

When you are happy with your scan 
set definition, click on the Save 
button in the Manage Scan Sets 
tool. The Scan Utility will then 
create all of the necessary tables in 
the SDE for your scan set.

Scan sets are deleted using the 
Manage Scan Sets tool. Select the 
scan set you want to delete and 
click on the Remove button. This 
will delete all of the SDE tables that 
make up the scan set, and can take 
several minutes to complete. A scan set can only be removed using an SDE account that has the 
ability to delete the SDE scan set tables.
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Running SDE Scan Utility in SDE Mode

After the SDE Scan Set is 
defined, running the Scan 
Utility in shape SDE mode is 
the same as running it in shape 
file mode described earlier in 
the section Running the Scan 
Utility in Shape File Mode. The 
Source Data Store, Projects, 
Coordinate System, and Output 
Features are selected exactly 
the same are described in detail 
in the earlier section. Running 
the scan utility in interactive 
mode and batch mode are the 
same, as well as all options.
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Using the OpenSpirit ArcMap Extension 

Overview

The OpenSpirit ArcView Extension is designed to be used with ESRI’s ArcMap 9.0 (or newer) 
product. This allows ArcMap (aka ArcView) to visualize and analyze the themes that are generated 
by the OpenSpirit Scan Utility and to send object selection, data selection, GIS Feature selection, 
and cursor tracking events to other OpenSpirit enabled applications. When used with the OpenSpirit 
data viewers, these combined utilities give users an extensive set of tools for browsing and selecting 
data from a variety of project data stores.

The ArcMap Extension must be run on Windows in conjunction with ESRI’s ArcMap (ArcView) 
version 9.0 (or newer). 

The OpenSpirit extension adds this tool bar to ArcView.

Installation

The OpenSpirit ArcMap Extension is distributed with the OpenSpirit Windows Runtime 
Installation. To install the Extension you can either:

1) Install as part of the original installation chosen to install the .NET options and select the 
ExcelAdapter option.

-or-

2) Subsequent to the original OpenSpirit Windows Runtime, if you did not elect to install the.NET 
options, you can later install the .NET options by executing setup.exe in the 
%OSP_HOME%\external\OpenSpirit.NET directory (usually C:\Program 
Files\OpenSpirit\external\OpenSpirit.NET).

After installing the ArcMap Extension you will need to make sure that a valid license feature key is 
available. To obtain an evaluation license you can send an email request to support@openspirit.com. 
The OpenSpirit ArcMap Extension is an optional add-on product to the OpenSpirit Base Framework 
and Subsurface Data Module products and requires a separate license. On UNIX, its license key is 
installed in the FLEXlm license file along with the other OpenSpirit license keys. If a license key is 
available, the OpenSpirit ArcMap Extension toolbar will appear in ArcMap.

Instructions for Use

The OpenSpirit ArcMap Extension adds toolbar icons to the ArcMap user interface. It appears in 
ArcMap as any other extension with its toolbar access controlled from the ArcMap menu Tools > 
Extensions. To use the OpenSpirit ArcMap Extension in ArcMap you must first use the OpenSpirit 
Scan Utility to generate shape files, or coverages in SDE, that contain the required OpenSpirit 
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specific attributes and ensure that the OpenSpirit ArcMap Extension is installed and enabled (see the 
section above regarding installation).

Add Datastore Themes

The first step in using the OpenSpirit ArcMap extension is adding the GIS features generated and 
saved as shape files or in SDE. The process is slightly different for shape files, or SDE.

Click on the add shape files icon  and navigate to the area where the shape files were saved 
from the Scan Utility. Every OpenSpirit data store installation scanned using the Scan Utility has an 
associated set of shape files. A .dbf file is created called datastore_master.dbf, where datastore is the 
name of your data store and is used to identify all of the shape files generated for a particular data 
store. When the user clicks on add shape files icon, a dialog is displayed that will locate the master 
dbf. When the user selects a master DBF, all the themes related to the same data store are added to 
the map's table of contents. 

Click on the add SDE scan sets icon to add scan sets from SDE. This will launch the Scan Set 
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Selection dialog. Enter the Server the SDE instance is running on and the Port number SDE is 

listening on. Next enter the SDE user and its password. Note the SDE user id can, and probably will 
be different from your UNIX or WINDOWS user ID. Additionally, the SDE user must have the 
proper SDE/Oracle permissions and access. Consult your SDE administration, and the SDE portion 
of the Scan Utility in this user guide for additional information on SDE roles. Click on the Connect 
button, and you will be presented a list of scan sets maintained in SDE. Click on the scan set you 
want to display in arc map and then the OK button. All of the themes related to this scan set are added 
to the ArcMap table of contents.

A data store's label properties in ArcMap can be controlled by changing the .lyr files located in the 
OpenSpirit Windows installation subdirectory external\ArcMapExtension. If you do not like the 
defaults that come with OpenSpirit save the .lyr file definition here and it will become the default 
definition for the OpenSpirit extension for the computer.

Options when Connected to an OpenSpirit Session

Select an OpenSpirit Session 

To interact with other OpenSpirit enabled applications from ArcMap, a connection first has to be 
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established with an OpenSpirit session. Clicking on the Session dialog box causes a drop-down list 
of available sessions to be displayed. Select the desired session as shown:

The OpenSpirit Toolbar icon will change to indicate a successful connection  and the name of 
the selected session will appear in the ArcMap Window Title and the OpenSpirit session dialog box.

Selection of a session then enables the other OpenSpirit Toolbar icons, and now you can send and 
receive OpenSpirit events. You ArcMap extension will look like the picture below:

Send Selection Events and Selection Options

The ArcMap Extension enables ArcMap to send and receive OpenSpirit selection events, just like 
any other OpenSpirit enabled application. Through selection events, the ArcMap user can 
communicate with other OpenSpirit enabled applications.

An ArcMap user can use ESRI's powerful spatial selection capability to identify specifically 
required data and then send an OpenSpirit selection event that contains references to all selected 

features can be sent by clicking on the Send Data Selection Events icon.  Any OpenSpirit 
enabled application can pick up this event, and access the data selected in ArcMap, even though the 
data is not resident in ArcMap itself.

The ArcMap Extension can also send OpenSpirit GIS events to other applications enabled to receive 
OpenSpirit GIS selection events. In ArcMap, a point, line or polygon can be selected using ESRI’s 
selection capability and then sent to the waiting application by clicking on the Send GIS Selection 

Events icon. 

OpenSpirit will send the GIS selection event through the OpenSpirit session. ArcMap coordinates 
and units will be converted to the OpenSpirit session’s coordinate system. Make sure your intended 
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shape file has a .prj file defining its datum, or your SDE layer has it datum correctly identified.  In 
addition, your must insure ArcMap Frame's Data Frame Properties >Coordinate System tab has the 
correct transformations to WGS84 set. Click on the ArcMap's Transformation button and inspect 
every Geographic Coordinate System Transformation to insure every system in the Convert from 
window has a conversion into WGS84 you want to use. This transformation, in most cases, should 
match the conversion used in your GeoFrame, OpenWorks, Kingdom, Petra, etc. project.

The Selection Options icon  launches the OpenSpirit Options dialog box where the ArcMap 

user can control the OpenSpirit ArcMap Extension’s behavior when it receives an OpenSpirit data 
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or GIS selection event.

The OpenSpirit Extension Options dialog box controls the OpenSpirit Extension's behavior when 
receiving an OpenSpirit data, or GIS, selection event. If Highlight Existing Features is checked, and 
you have a layer in ArcMap created from an OpenSpirit Selection Event, or the OpenSpirit Scan 
Utility, then the item will be highlighted, or selected, in ArcMap. If the Create New Features is 
checked, and the ArcGIS Extension receives an Object Selection Even from another OpenSpirit 
enabled application such as the DataSelector, then the ArcGIS Extension will generate a shape file 
for each object. The Grouping By column allows you to control if there are one, or multiple shape 
file made for each data type. Note that this capability to create shapefiles "on the fly" from selection 
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events is only intended for 10’s of items. If you want to produce shapefiles for hundreds, or hundreds 
of thousands of items, you must use the OpenSpirit Scan Utility.

The ArcMap Extension's workspace directory is controlled by selecting the Workspace Directory. 
This directory will be where any received data files will be stored.

There are three types of selection events that can be sent:

Data Selection Events

This message type contains datakeys (references to items in vendor data stores). This is a newer type 
of selection event that has the advantage of being very efficient when dealing with a large number 
of selected items. Since this is a new type of event, not all OpenSpirit enabled applications listen to 
this event type yet.

Data Selection Events can be sent for the following selected features and then viewed in the 
indicated OpenSpirit viewer or utility. Other third-party OpenSpirit enabled applications can also 
respond to these selection events. To receive events, the OpenSpirit viewer or another third-party 
application must be connected to the same OpenSpirit Session and the ArcMap Extension.

In order for an OpenSpirit selection event to be sent, the appropriate OpenSpirit data connectors 
must be running. These remote UNIX based data connectors will be automatically started as 
required, but when data is first selected from a project there will be an initial delay as the required 
connectors start. Also, if data is selected from five or more projects, a warning message will be 
displayed to remind the user that many data connectors might need to be started. During the data 
connector startup period, the OpenSpirit toolbar icons will be disabled

Feature Type OpenSpirit Utilities which can listen for data 
selection events

Project DataSelector

Wellbore, Wellbore path DataSelector, Well Viewer, 3D Viewer, Excel Adapter

3d seismic volume DataSelector, Section Viewer, 3D Viewer

3d seismic survey DataSelector

2d seismic line DataSelector

2d seismic dataset DataSelector, Section Viewer, 3D Viewer

Horizon representations 
(from Horizon table)

DataSelector, Section Viewer, 3D Viewer
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GIS Feature Selection Event

This message type contains the name, corresponding layer name, and geometry of the selected 
features. This message allows OpenSpirit easy access to a limited amount of GIS data in an area of 
interest.

GIS Feature Selection Events can be sent for the following selected feature types and then viewed 
in the indicated OpenSpirit viewer or utility. Other third-party OpenSpirit enabled applications can 
also respond to these selection events. To receive events, the OpenSpirit viewer or another third-
party application must be connected to the same OpenSpirit Session and the ArcMap Extension.

Send Cursor Location 

Users can broadcast a cursor location event from ArcMap to OpenSpirit enabled applications (such 
as the 3D Viewer) by selecting the Send Cursor tool button and moving the mouse on the ArcMap 
map. Note that the cursor location can be sent from a map view regardless of whether it is displayed 
in geographic coordinates (e.g. latitude– longitude) or map projection coordinates (in either case 
ArcMap broadcasts the correct geographic position).

Receive Cursor Location 

User can receive location events from an OpenSpirit enabled application (such as the 3D Viewer) by 
selecting the Receive Cursor tool button and moving the mouse in the OpenSpirit enabled 
application.

Display OpenSpirit Information 

The ArcMap OpenSpirit Information icon provides further information on 3D surveys, volumes, and 
interpretation information, along with non-seismic grids. The tool sends data selection events, or 
creates ESRI GRID images to represent horizons and non-seismic grids. Click on the Display 
OpenSpirit Information icon, and then click on a polygon representing a 3D survey or a 2D grid. If 
you have overlapping 3D surveys and 2D grids, then the following Feature Selection dialog will 

Feature Type OpenSpirit Utilities which can listen for GIS 
Feature selection events

Point Excel Adapter

Polyline Excel Adapter

Polygon DataSelector, Excel Adapter
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appear. Select the 3D survey, or 2D grid you want to work with.

After you have selected you 3D survey, or grid, a tailored dialog box with the data from the grid or 
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survey will appear like the one below.:

This dialog displays all the seismic volumes, horizons and non-seismic two dimensional grids that 
are associated with the selected area.

The source of the displayed 
data is controlled by this 
radio button group. 

If the Query db option is 
selected, then the appropriate OpenSpirit data connectors will start on UNIX and a current list of 
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horizons, grids and seismic volumes will be displayed. If the Shape files option is chosen, then the 
list includes those items that were current when the OpenSpirit Scan utility was last run. Note that 
if the Query db option is selected there can be some time delay as the OpenSpirit data connectors 
are first started.

Sending Selection Events from the 3D Seismic Survey Dialogue 

If a seismic volume or horizon row is highlighted then a selection event may be sent by clicking on 
the Speaker icon.

Importing a Seismic Horizon or 2D Grid into ArcMap 

Select a horizon, or two dimensional grid in the Horizon tab. Next, click on the Properties tab and 
select a property associated with the horizon or grid and the Horizon Image icon is activated and one 
can create either a TIFF image or ESRI GRID file in the current ArcMap project by clicking on the 

Horizon Image icon . The image type and amount of decimation (if any) is controlled by the 
settings in the Image Preferences box.   A default rainbow color map is also created with the desired 
contour increment. Note that the ESRI GRID format has a restriction that the grid must be square 
so the inline and crossline spacing must be equal.

Due to ESRI limitations, the output directory must be a Windows based directory.
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Example of seismic horizons displayed in ArcMap.2

Set Project Passwords

Some data stores, such as Finder and GeoFrame, require that a project password be supplied in order 
for a user to connect to a project. This toolbar icon allows you to set passwords for projects 
corresponding to selected features. These passwords will then be used by the OpenSpirit data 
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connectors to allow them to connect to the selected project.

Tips for Setting Display Attributes on OpenSpirit Features

ArcView has many options for setting the display properties of spatial features in its map view. The 
following are some tips that can improve the look and utility of your ArcView map displays:

• The OpenSpirit wellbore path and 2D seismic lines have a measure property (measured depth 
on the wellbore path and SP on the 2D seismic lines) that can be displayed along the path using 
the "hatching" capability available in ArcView 8.3 or newer

• The OpenSpirit well feature has a number of attributes (e.g. well status, fluid type, flow 
direction) that can be used to set the display symbology to indicate well type and status (use 
the "Unique values, many attributes" option under the "Categories" option in the well layer 
Symbology tab in the Layer Properties dialogue)

• If you are displaying features from multiple datastores in the same map you may wish to 
display upper layers with a narrower line width or symbol size so that it is easier to recognize 
when the same data item is present in multiple datastores.
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Using the Excel Adapter

Overview

The OpenSpirit Excel Adapter is an optional add-on product to the OpenSpirit Subsurface Data 
Module. This utility allows users to listen for OpenSpirit data or object section events and then paste 
desired data attributes into Excel. The Excel Adapter can also receive OpenSpirit point and GIS 
feature events. This enables a variety of ad-hoc reporting and data reformatting tasks to be 
performed in a tool, Excel, that most users are already familiar with.   Data or object selection events 
may be sent from:

Data Types Covered

The current version covers the following well data types:

Any of the OpenSpirit data viewers (well, section, or 3D)

The OpenSpirit DataSelector

ArcView (via the OpenSpirit Extension)

Native Landmark OpenWorks based applications (via the 
OpenSpirit OpenWorks event gateway)

Native Schlumberger GeoFrame based applications (via the 
OpenSpirit GeoFrame event gateway)

Other third-party OpenSpirit enabled applications

Well/Wellbore header

Wellbore path data (including plot option)

Well log header

Well log trace data

Well picks

Usage Note:

If the application 
that you are using 

to sent selection events 
supports sending data 
selection events, we 
strongly recommend that 
you only send data 
selection events. The 
default in the 
DataSelector and the 
ArcView Extension is to 
send both data and 
object selection events.
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Data from any data store with an OpenSpirit well data connector that implements the OpenSpirit 
attribute query interface can be accessed.

Event Types Covered

The current version covers the following event types:

Well velocity header (checkshot)

Checkshot time-depth tables (including plot option)

3D Seismic survey

3D Seismic Volume

2D Seismic survey

2D Seismic line

2D Seismic dataset

Earth Model

Horizon

Fault

Horizon-Fault Boundary Set

Culture Point Polyline and Polygon Layers

Simple Point Events

GIS Feature Selection (Point, Polyline and Polygon)

Data Selection

Object Selection

Point of interest

Area of Interest

Cursor position
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Installation Prerequisites

The OpenSpirit Excel Adapter assumes that either Excel 2000 (part of Office 2000) or Excel XP 
(part of Office XP) is available on Windows and that OpenSpirit is installed.

Installation 

The OpenSpirit Excel Adapter is distributed with the OpenSpirit Windows Runtime. To install the 
Excel Adapter either:

1) As part of the original installation choose to install the .NET options and select the ExcelAdapter 
option

-or-

2) Subsequent to the original OpenSpirit Windows Runtime installation, if you did not elect to install 
the.NET options, you may install the .NET options by executing setup.exe in the 
%OSP_HOME%\external\OpenSpirit.NET directory (usually C:\Program 
Files\OpenSpirit\external\OpenSpirit.NET).

After installation of the Excel Adapter you will need to ensure that a valid license feature key is 
available. To obtain an evaluation license send an email request to support@openspirit.com. The 
OpenSpirit Excel Adapter is an optional add-on product to the OpenSpirit Base Framework and 
Subsurface Data Module runtime products and requires a separate license. 

Launching the Excel Adapter and Excel

The Excel Adapter is launched from the OpenSpirit Launcher Utilities menu, running on Windows.

GIS Point Feature

GIS Polyline Feature

GIS Polygon Feature
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Then start Excel from the toolbar icon in the Excel Adapter:

The toolbar gives the user access to useful task:

In order to receive selection events you must connect the Excel adapter to the same session as the 
application that will be sending OpenSpirit selection events. The desired session may be selected 
from the combo box in the toolbar. When a session connection is made the OpenSpirit logo will 
display a lightening bolt indicating that it is enabled for listening and the session unit and coordinate 
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Usage Note:

You must launch 
Excel from the 

OpenSpirit Excel 
Adapter in order for the 
adapter to be able to 
paste data into Excel. 
Excel will start up with 
an empty workbook. You 
may, however, open an 
existing workbook and 
the adapter will paste 
data into this workbook.
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preferences, if present, will be displayed.

Setting General Preferences

Worksheet Options - options to control the behavior of the adapter when a selection event is 
received 

Add rows to worksheets - this option will cause any new data items to be appended to the 
appropriate worksheet at the first empty row.

Clear worksheets - this option will first clear the appropriate worksheet and then paste in 
the received data items.

Unit Preferences - this option controls what units will be used in displaying attributes that have units 
(e.g. the TD of a wellbore, the x and y offset of the wellbore path, etc.) 

Use session units - this option is only available if there are unit preferences set on the 
session. If chosen, all data quantities will be converted to the session preferred units 
regardless of what units the data is stored in the project.

Standard Metric -if chosen, all data quantities will be converted to the standard metric units 
regardless of what units the data is stored in the project.

Standard Imperial -if chosen, all data quantities will be converted to the standard imperial 
units regardless of what units the data is stored in the project.

Project Units - if chosen all data will be displayed in its native project units without any 
conversion.

Coordinate System preferences - this option controls what coordinate system will used in displaying 
attributes that have a spatial location (e.g. the well surface location).

Use project coordinate system - if chosen, all data will be displayed in its native project 
coordinate system without any conversion.

Use session’s map projection system - this option is only available if there is a coordinate 
system preference set on the session. If chosen, all spatial data quantities will be converted 
to the session preferred coordinate system regardless of what coordinate system the data 
is stored in the project.
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Setting Data Preferences

Well Data

The Well tab allows the user to select which data types they are interested in and what type of 
selection events they wish to respond to. 

Use session’s geographic system - this option is only available if there is a coordinate 
system preference set on the session. If chosen, all spatial data quantities will be converted 
to the session's preferred geographic system regardless of what coordinate system the 
data is stored in the project.

Wellbore - well and wellbore header attributes

Listen - if chosen, the adapter will respond to well bore selection events and the desired 
attributes pasted into a worksheet titled "Well Bore"

None - if chosen, well bore selection events will be ignored

Path - only available when "Listen" is chosen and if chosen, will cause the wellbore path 
information (X-offset, Y-offset, TVD, MD) to be pasted into a worksheet titled "Path Data"

Plot - only available when "Path" is chosen and if chosen, will cause the wellbore 
path information to be plotted in two sheets - "Well Path (X)" and "Well Path(Y)"

Well Logs - well log header attributes

Listen - if chosen, the adapter will respond to well log selection events and the desired 
attributes pasted into a worksheet titled "Well Log"

From wellbore selection - if chosen, the adapter will respond to wellbore selection events 
and the desired attributes pasted into a worksheet titled "Well Log" for every log associated 
with the received wellbores

None - if chosen, well log selection events will be ignored and no well log attributes pasted 
into Excel

Trace Data - available if either "Listen" or "From wellbore selection" options are chosen. If 
chosen, the log and depth values will be pasted, for the indicated measured depth range 
into a worksheet titled "Log Data"

Logging Passes - logging pass (log run) attributes

Usage note:

Excel Worksheet only 
allows 65,536 rows. Any 

additional rows will be 
discarded. 

Excel Charts only allows the 
first 30 wellbore paths plotted. 
Additional wellbore paths will 
be discarded.
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Seismic Data

The Seismic tab allows the user to select which data types they are interested in and what type of 

Listen - if chosen, the adapter will respond to logging pass selection events and the desired 
attributes pasted into a worksheet titled “Logging Passes”

From wellbore selection - if chosen, the adapter will respond to wellbore selection events 
and the desired attributes pasted into a worksheet titled "Logging Passes" for every log 
pass associated with the received wellbores

None - if chosen, well pick selection events will be ignored and no well pick attributes 
pasted into Excel

Well Picks- well pick (marker) attributes

Listen - if chosen, the adapter will respond to well pick selection events and the desired 
attributes pasted into a worksheet titled "Well Pick"

From wellbore selection - if chosen, the adapter will respond to wellbore selection events 
and the desired attributes pasted into a worksheet titled "Well Pick" for every pick 
associated with the received wellbores

None - if chosen, well pick selection events will be ignored and no well pick attributes 
pasted into Excel

Checkshots - well checkshot header attributes

Listen - if chosen, the adapter will respond to well velocity (checkshot) selection events and 
the desired attributes pasted into a worksheet titled "Well Velocity"

From wellbore selection - if chosen, the adapter will respond to wellbore selection events 
and the desired attributes pasted into a worksheet titled "Well Velocity" for every well 
velocity (checkshot) associated with the received wellbores

None - if chosen, well velocity (checkshot) selection events will be ignored and no well 
velocity (checkshot) attributes pasted into Excel

T-D data - available if either "Listen" or "From wellbore selection" option is chosen and if 
chosen, will cause the time-depth data to be pasted into a worksheet titled "Well T-D Data"

Plot - only available when "T-D Data" is chosen and if chosen, will cause the T-D 
information to be plotted in a sheet titled "Time vs. Depth"
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selection events they wish to respond to. 

3D Survey - 3D seismic survey attributes

Listen - if chosen, the adapter will respond to 3D seismic survey selection events and the 
desired attributes pasted into a worksheet titled "3D Survey"

None - if chosen, 3D seismic survey selection events will be ignored

Corner Point Locations - only available when "Listen" is chosen and if chosen, will cause 
the x, y location of the survey 4 corner points to be pasted into a worksheet titled "3D 
Survey Corners" (Note the project coordinates for x, y are inline crossline. If you want real 
world coordinates you must select the option to use the session's coordinate system) 

3D Seismic Volume- 3D seismic volume attributes

Listen- if chosen, the adapter will respond to 3D seismic volume events and the desired 
attributes pasted into a worksheet titled "3D Volume "

From 3D Survey Selection- if chosen, the adapter will respond to 3d survey selection 
events and the desired attributes pasted into a worksheet titled "3D Volume" for every 3D 
volume   associated with the received 3D surveys

None- if chosen, 3D seismic volume selection events will be ignored and no 3D seismic 
volume attributes pasted into Excel

2D Survey - 2D seismic survey attributes

Listen - if chosen, the adapter will respond to 2D seismic survey selection events and the 
desired attributes pasted into a worksheet titled "2D Survey"

None - if chosen, 2D seismic survey selection events will be ignored

2D Seismic Line- 2D seismic line attributes

Listen- if chosen, the adapter will respond to 2D seismic line events and the desired 
attributes pasted into a worksheet titled "2D Line"

From 2D Survey Selection- if chosen, the adapter will respond to 2D survey selection 
events and the desired attributes pasted into a worksheet titled "2D Line" for every 2D line   
associated with the received 2D surveys

None- if chosen, 2D seismic line selection events will be ignored and no 2D seismic line 
attributes pasted into Excel
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Interpretation Data

The Interpretation tab allows the user to select which data types they are interested in and what type 
of selection events they wish to respond to.

2D Seismic Dataset- 2D seismic dataset attributes

Listen- if chosen, the adapter will respond 2D seismic dataset events and the desired 
attributes pasted into a worksheet titled "2D Dataset"

From 2D Survey Selection- if chosen, the adapter will respond to 2D survey selection 
events and the desired attributes pasted into a worksheet titled "2D Dataset" for every 2D 
dataset associated with the received 2D surveys

None- if chosen, 2D seismic dataset selection events will be ignored and no 2D seismic 
dataset attributes pasted into Excel

Earth Model - earth model attributes

Listen - if chosen, the adapter will respond to Earth Model selection events and the desired 
attributes pasted into a worksheet titled "Earth Model"

None - if chosen, Earth Model selection events will be ignored

Horizon- horizon attributes

Listen- if chosen, the adapter will respond to horizon events and the desired attributes 
pasted into a worksheet titled "Horizon"
note: at this time the adapter does not listen for 2D interpretations or non-seismic grids

From Earth Model Selection- if chosen, the adapter will respond to Earth Model selection 
events and the desired attributes pasted into a worksheet titled "Horizon" for every horizon   
associated with the received Earth Models

None- if chosen, horizon selection events will be ignored and no horizon attributes pasted 
into Excel

Fault- fault attributes

Listen- if chosen, the adapter will respond to fault events and the desired attributes pasted 
into a worksheet titled "Horizon”
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Culture Data

The Culture tab allows the user to display and collect attributes from the OpenSpirit SDE Culture 
selected and broadcasted from the OpenSpirit DataSelector.

From Earth Model Selection- if chosen, the adapter will respond to Earth Model selection 
events and the desired attributes pasted into a worksheet titled "Fault" for every fault   
associated with the received Earth Models

Type - can pick either Polyline Set (fault sticks), or just the Point Set that makes up the 
faults.

Fault Properties - Will display all of the properties associated with each fault in a separate 
worksheet titled "Fault Properties".

None- if chosen, fault selection events will be ignored and no fault attributes pasted into 
Excel

Horizon-Fault Boundary Set - fault boundary attributes

Listen- if chosen, the adapter will respond to fault boundary events and the desired 
attributes pasted into a worksheet titled "Horizon-Fault Boundary"

Display boundary summary- provides the corner coordinates for the fault boundary.

Display geometry- provides all of the xy information and data for the fault boundary.

None- if chosen, Horizon-Fault boundary set selection events will be ignored and no fault 
attributes pasted into Excel

Point Layer - controls SDE point layer types

Polyline Layer - controls SDE line layer types

Polygon Layer - controls SDE polygon layer types

Layer controls:

Listen - respond to culture events sent to the ExcelAdapter for this layer type and return 
information on the Layer selected to an Excel tab named Point Layer, Polyline Layer, or 
Polygon Layer.

None - ignore culture events sent to the ExcelAdapter for this layer type
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Select Attributes to Display

For any selected data type you can select the attributes to display 
by clicking on the Set Attributes to Display button.

You may select or deselect attributes by holding the Ctrl key down 
and then clicking on desired attribute names. A contiguous block 
of attributes may be selected by holding down the Shift key. You 
may also easily select all attributes or return to the default set by 
using the corresponding buttons.

Types of Selection Events

The Excel Adapter responds to both object selection and data selection events. OpenSpirit 

Feature Controls:

Listen - responds to culture events sent to the ExcelAdapter for this feature type, 
irregardless if the Layer control is set to Listen or not. Information on the feature is posted 
in an Excel tab named Point Feature, Polyline Feature, or Polygon Feature.

From layer selection - If layer control is set to Listen, returns all objects for this feature type 
from the selected layer. Information on the feature is posted in an Excel tab named Point 
Feature, Polyline Feature, or Polygon Feature.

None - No features returned or Feature tabs created in Excel.

Display all feature attributes - Returns all of the attributes for the selected feature. 
Attributes for the feature are posted in an Excel tab named Point Feature Attribute, 
Polyline Feature Attribute, or Polygon Feature Attribute.

Display feature geometry - only available when "Listen" is chosen. The x,y location 
information for each feature, with associated project, layer, and feature information is 
posted in an Excel tab named Point Layer, Polyline Layer, or Polygon Layer.
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applications will send one or the other and some both. 

Given a choice, sending a data event is the preferred option. The OpenSpirit DataSelector and 
ArcView extension both offer the option of sending data selection events.

Other Event Types

The Excel Adapter can also respond the event types listed in the Events tab and paste in the spatial 
location for these event types. The coordinate system is controlled by the setting in the General tab. 
If the Use project coordinate system section is chosen then the location information of the events 
will be in the sender's coordinate system. Otherwise the location information will be converted into 
session's geographic or map coordinate system.

Object Selection Event: A message containing references to OpenSpirit objects. This is the 
traditional selection event type that most OpenSpirit enabled applications that listen for selection 
events use. Sending an object selection event containing many selected objects may be slow as 
every object needs to be created in the remote OpenSpirit data connectors. 

Data Selection Event: A message containing datakeys (references to items in vendor datastores). 
This is a newer type of selection event that has the advantage of being very efficient for large number 
of selected items. As this is a new type of event, not many OpenSpirit enabled application yet listen 
to this event type.
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Using the Event Gateways

The Event Gateway is only available on UNIX based systems. User interactions or events can be 
shared between applications within the GeoFrame or OpenWorks suite. For example, one can select 
a well or well log in one application and “broadcast” this selection event to other applications. Users 
can also share the 3D cursor locations between applications. With the OpenSpirit Event Gateway, 
the user can also bidirectionally share these events with any OpenSpirit enabled application. 

OpenWorks Event Gateway

This gateway currently supports bidirectional object selection events for Well, WellBore, WellPick, 
and WellLogTrace and cursor location events. Selection events for other object types will be added 
in future releases of OpenSpirit.

Depending on how your 
site has installed and 
configured OpenSpirit, 
the OpenSpirit Event 
gateway can be either 
launched from the 
Landmark OpenWorks 
Launcher or the 
OpenSpirit Launcher 
(from the Tools menu).

Launched from OpenSpirit Launcher

If you have launched the Event Gateway from the OpenSpirit launcher then the session and display 
will be set to the current values established in the OpenSpirit Launcher. If your OpenSpirit Session 
contains more than one project coming from different OpenWorks Oracle instances then you will 
need to select the appropriate datastore from the right most pull-down list.

Launched from OpenWorks Launcher

If you have launched the Event Gateway from the OpenWorks launcher then the X display will be 
set to the correct value but you will need to select the desired OpenSpirit Session from the left most 
pull-down list. If your OpenSpirit Session contains more than one project coming from different 
OpenWorks Oracle instances then you will also need to select the appropriate datastore from the 
right most pull-down list.

Once the desired OpenSpirit Session, X display, and OpenWorks data is selected you should click 
on the Start button. The OpenWorks Event Gateway will then be started (it can take a few moments 
before it starts if many data connectors need to be started first). To shutdown the Event Gateway at 

Windows Note: 
The OpenWorks 
and GeoFrame 

Event Gateway must be 
run on UNIX, though the 
display can be set back to 
a Windows host (if you 
are running OpenWorks 
applications via an X-
server on the Windows 
host) 

Usage Note: The 
OpenWorks 
Launcher must be 

running and a project 
selected before the 
OpenSpirit OpenWorks 
Event Gateway will start.
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the end of your session simply click on the Shutdown button.

GeoFrame Event Gateway

The GeoFrame Event Gateway only supports GeoFrame 4.x projects. It currently supports 
bidirectional object selection events for Well, WellBoreList, WellBore, WellPick, WellLogTrace, 
and WellVelocity. Similar to the GeoFrame 4.0 data connector, the GeoFrame Event Gateway needs 
to be run on UNIX platform.

Launched from OpenSpirit Launcher 

If you have launched the GeoFrame Event Gateway from the OpenSpirit Launcher, the session will 
be set to the current values established in the OpenSpirit Launcher. If your OpenSpirit Session 
contains more than one GeoFrame 4.x data store installation, you will need to select the appropriate 
datastore from the middle pull-down list. If your OpenSpirit Session contains more than one 
GeoFrame project, then you will need to select the appropriate project from the right most pull-down 
list. If you want to start the GeoFrame Event Gateway with a different session than the Launcher's 
current session, you can select the desired session from the left most pull-down menu. 

Once the desired OpenSpirit Session, GeoFrame data source installation, and GeoFrame project are 
selected, you should click on the Start button. The GeoFrame Event Gateway will then be started (it 
can take a few minutes before it starts if many data connectors need to be started first). Once the 
Event Gateway is running, the Start button will change to Shutdown button. To shutdown the Event 
Gateway, simply click on the Shutdown button. 

Usage Note: The 
GeoFrame 
Application 

Manager for the selected 
project must be running 
in order to be able to 
start the GeoFrame 
Event Gateway.

CHAPTER 2 OpenSpirit Tutorial



119

3   OpenSpirit Administration Guide

elcome to the OpenSpirit Administration Guide. This document presents all aspects of 
installing, configuring, verifying, and administering an OpenSpirit installation. 

The environment where OpenSpirit is installed can be complicated and can vary 
significantly at each site and even within a single site. While substantial testing has 

taken place prior to delivering the commercial OpenSpirit Installation Kit(s), it is expected that some 
scenarios have not been encountered. Therefore, along the way common pitfalls and complexities 
are pointed out to help avoid problems and to deal with unique environmental issues.

This chapter will describe the required environment for OpenSpirit to operate properly, the 
installation and configuration process, how to start OpenSpirit, how to verify that it is working and 
then point out key areas to watch as the installation is used. This chapter assumes that you proceed 
through this process without running into any problems. The Support and Trouble Shooting Guide 
should be referenced if you run into problems.

Getting Started
This section describes the information gathering process. It includes hardware and software as 
well as specific account requirements.

Installation
Install OpenSpirit and perform some initial configuration procedures. All the OpenSpirit tools work 
equally well on Solaris, Linux and Windows. There are separate install kits for each supported 
platform.

OpenSpirit Desktop Administrator tools
•  Data Store Configuration 
•  Installation Admin Tool
•  License Admin Tool
•  User Manager Tool

Help documentation for these tools is now available online from the tools and therefore 
not included in this guide.

Managing Shared Services
Before end users can use OpenSpirit, some processes need to be started. These processes are 
managed by a single script. These services should be managed by someone with an 
Administrative role.

License File Management
This section describes how FLEXlm licenses work with OpenSpirit.

W
Usage Note: The 
most common 
problems 

encountered when 
configuring OpenSpirit 
result from a lack of 
information provided 
about your data store 
installations. OpenSpirit 
installation and 
configuration is 
straightforward if you 
know your application 
environment and 
corresponding Oracle 
database environment.
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Getting Started

Gathering Information

Before getting started, it is a good idea to review this section and gather all of the pertinent 
information. Thinking about this information before getting started will make the process much 
easier and will reduce the chances of error. After reviewing the short sections on hardware, software, 
and user account requirements, begin to gather the detailed information that will be required during 
installation and configuration.

Installation Types

There are two different types of OpenSpirit Runtime installations that are possible a Master and a 
Satellite. A general overview of the 2 types of installations is:

• Master - a Master installation is the main type of OpenSpirit installation and is required by the 
other types of OpenSpirit installations. There are two main functions of a Master installation. 
The first function is to run the OpenSpirit shared services. These are services that all users of 
OpenSpirit have access to and include modules to perform coordinate transforms, unit 
conversions, and event notifications. The second function is to create and manage the 
OpenSpirit database. This database is used by OpenSpirit for storing both system information 
and user information.

• Satellite - Satellite installations provide the ability to run OpenSpirit data connectors on 
different servers, running different (or the same) operating system that are only connected via 
the client's network. Satellite installations must have a corresponding Master installation that it 
“points” to however, having a shared file system is not required between the master installation 
and the satellite installations.

Operating System Requirements

OpenSpirit supports master and satellite installations on the following operating systems:

• Sun Solaris

• Linux RedHat

• Microsoft Windows 

Performance:
One way to 
distribute CPU 

load is to run the 
OpenSpirit data 
connectors on multiple 
machines.
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Hardware Recommendations

For the OpenSpirit Master server installation, we recommend the following:

Space Requirements

Below are the approximate disk space requirements for each supported platform.

Solaris:
- Sun Blade 1000 or better
- 2 Gb RAM 
- 1Gb of swap

Linux:
- 3 GHz Pentium 4 (or equivalent)
- 2 Gb RAM
- 80 Gb SATA disk drive
- standard graphics card for a Windows PC

Windows:
- 3 GHz Pentium 4 (or equivalent)
- 2 Gb RAM
- 80 Gb SATA disk drive
- standard graphics card for a Windows PC

Platform Installation 
Kit Size Installed Size

Solaris
~ 545Mb Master = ~1300Mb

Satellite = ~760Mb

Linux
 ~566Mb Master = ~950Mb

Satellite = ~800Mb

Windows
 ~390Mb Master = ~724Mb

Satellite = ~520Mb
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User Account Requirements

OpenSpirit requires the use of some specialized user accounts for installation and configuration 
tasks. Depending on the security in place at your site, there are existing accounts common at most 
sites that can be used. However, you can create accounts with the minimal requirements if desired. 
As a start you should review the following, but there is also a more detailed section in the Support 
and Troubleshooting Guide for the Database Administrator that details the specific privileges each 
required account needs.

Installation Account

It is highly recommended that you create a separate login account to be used for the installation of 
OpenSpirit. Even though this is not mandatory, it simplifies the installation process. A typical name 
of the login account is spirit. 

It is not recommended that you install OpenSpirit as root. The root userid is a special account and 
should not own an installation or the processes that run from it.

Root Access

Installing OpenSpirit does not require root access. However, you may want to start up the OpenSpirit 
services each time your machine is rebooted. The script, OpenSpirit_init.d, located in the 
$OSP_HOME/bin/etc directory can be used for this purpose. Setting this up will require root 
privileges.

Additional Information Before Getting Started

During installation and configuration various information about the environment is required. The 
Support and Troubleshooting Guide will help you find the likely places to look in order to find the 
right answers. It is highly recommended that you gather this information before proceeding with 
installation. This will help reduce the chance of human error during input of data. And if you do run 
into problems that require an OpenSpirit engineer’s involvement, this information will be required.

Reviewing the information may seem overly complex, but these are necessary and are not unlike 
those requirements for successful installation of GeoFrame and/or OpenWorks. Taking the time to 
gather the information and enter it correctly will substantially increase the likelihood of a successful 
OpenSpirit installation. Just like GeoFrame, or OpenWorks, entering one value incorrectly increases 
the likelihood of an unsuccessful installation. The OpenSpirit installation and configuration attempts 
to validate the information entered, but there are limitations to what can be checked. You only need 
to do this once per installation.
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Good luck! If problems are encountered or questions arise please consider the following support 
possibilities: go to the Contact Us section of the Support and Troubleshooting Guide. Depending on 
the specific problem you are having, you may be asked to provide some information regarding your 
environment so that the support engineer can quickly and efficiently resolve your problem.
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Installation

Installation is performed using an OpenSpirit install kit, available at www.openspirit.com/supportdl. The install kit 
will guide you through the various phases of installation and install all the files needed to run OpenSpirit services and 
applications. There are also separate install kit for Solaris, Linux, and Windows. All installation kits give you the 
option to a master or satellite installation. All kits look the same, but perform some different tasks.

Prerequisite Checks

Please visit the pre-installation webpage to find important information regarding installation prerequisites. Some 
prerequisite checks should be performed to be sure that the system is compatible with OpenSpirit's requirements.

Starting the Installer

Once the desired OpenSpirit install kit is downloaded you start the installer, from within the directory where you 
copied it. The installer’s initial display will appear. Simply follow the instructions on each screen. Once the master 
installation is complete and running, you can run any of the needed satellite install kits. During the installation process 
for the satellites you will be asked to supply information about the master installation:

Obtain a License and Start the Shared Services

Before you can run OpenSpirit, you need to complete configuration, get a license file, and then start the Shared 
Services. These are described in the following sections. Please contact support@openspirit.com if you do not already 
have a license file.

http://www.openspirit.com/support/14.htm
http://www.openspirit.com/supportdl
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Managing Shared Services

The OpenSpirit Shared Services are those processes that are shared between all users accessing a particular installa-

tion. On UNIX based installation they are started using the OpenSpirit administrator account (the login account used 

for the installation) by executing the script

$OSP_HOME/bin/runOSServices.sh <option>

The usage options for the script are:
start start the shared services runOSServices.sh start
stop stop the shared services runOSServices.sh stop
status status of the shared services runOSServices.sh status

This script can be configured to start at bootup and shutdown when the machine is stopped. An example script 

(OpenSpirit_init.d) can be found in $OSP_HOME/bin/etc. 

In a Windows Master installation the OpenSpirit Shared Services start automatically as Windows services and are 

configured during the installation procedure.

Below is a list and short description of the shared services.

When running the start script you should observe something similar to the following;

FLEXlm License Daemon Manages all OpenSpirit licenses.

Notification Service Provides the OpenSpirit Event mechanism. Allows objects to 
send messages via an event channel to objects that have all 
registered interest. 

SharedServices 1) Unit of Measure:
Perform units conversions

2) Coordinate Server:
Performs geodetic datum shifts, cartographic projections/
transformations and user-defined transformations.

3) Reference Value Server:
Returns a list of allowable values for a specific type and 
performs optional translation between reference value 
sets.

4) Data Store Descriptors Servers:
Required for each data store type that is configured. 
Provides information about each data store.

5) User Alias Server:
Provides userid recognition for all users running 
OpenSpirit.



128

CHAPTER 3 OpenSpirit Administration Guide

% ./runOSServices.sh start
Running on: SunOS agate 5.9 Generic_118558-05 sun4u sparc SUNW,Sun-Blade-1000
Starting OpenSpirit v3.2.0 Build 266(OSP port=15320) services...
Found an existing license daemon...
Starting Notification service...
Notification Service running as pid 27564
### - Waiting for Notification Service to come up..
Starting shared services 
### - Waiting for SharedServices server to come up......
OpenSpirit services are now running...

When stopping the services you should observe the following:
% ./runOSServices.sh stop
Running on: SunOS agate 5.9 Generic_118558-05 sun4u sparc SUNW,Sun-Blade-1000
Stopping OpenSpirit v3.2.0 Build 266 (OSP port=15320) services...
Shutting down the installation
Sent installation-wide shutdown event on Jan 24, 2008 5:51:58 PM
Installation shutdown event sent: Thu Jan 24 17:51:59 CST 2008
Killing Notification Service (pid=27564) at Thu Jan 24 17:52:39 CST 2008
OpenSpirit services are now stopped...

When using the status options you should observer the following:
% ./runOSServices.sh status
Running on: SunOS agate 5.9 Generic_118558-05 sun4u sparc SUNW,Sun-Blade-1000
Checking status of OpenSpirit v3.2.0 Build 266 (OSP port=15320) services...
The Notification Service appears to be running as pid:     27728
OpenSpirit Shared Services server appears to be running on 'agate'

License File Management

OpenSpirit uses FLEXlm to manage licensed access to all OpenSpirit features and Client applications. The 
OpenSpirit license file including client application licenses must be obtained from OpenSpirit Corporation 
via support@openspirit.com.

Once a license file is obtained it should be placed in the default location of $OSP_HOME/external/flexlm/
license.dat. When OpenSpirit is started it will look for a license file running on port 27001 and the license 
file in the default locations.

Use the License Admin Tool to make any changes to the location of the license file or perhaps start the 
FLEXlm daemon on a different machine then where OpenSpirit is installed.
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ou have come to this section because you have encountered problems and need help solving them. Before 
contacting OpenSpirit Corporation for support, please go through the steps below. This section will point 
you to the various places where you can find pertinent information to your specific problem. Following the 
process outlined in this section will ensure the fastest resolution to the problems you are having.

Step 1- Is the Problem with OpenSpirit?

Since OpenSpirit is an application integration platform, you are normally using OpenSpirit with other vendors’ 
applications. Therefore, the problem could be with those applications rather than with OpenSpirit. We recommend that 
you check the other applications and make sure that they are up and running. If the problem still persists and you are 
fairly sure that the problem is with OpenSpirit, then continue on to the next step. 

Step 2- Review the Release Notes

Quickly review the Release Notes for known problems at the time of shipping. If you don't find anything necessary to 
solving your specific problem, then continue on to the next step.

Step 3- Review the Troubleshooting Guide

The Troubleshooting Guide, located on page 131 of this manual, provides some useful tips on diagnosing common 
problems. It is a self-help guide that explains what to look for in diagnosing common problems. If you still do not find 
any information pertinent to your specific problem, then continue on to the next step.

Step 4- Review the OpenSpirit FAQ Knowledge Base

In many cases the problem you have encountered will have already been found by someone else after the product was 
shipped. Our support department keeps a log of common problems in a FAQ Knowledge Base on the OpenSpirit web 
site. The information in the knowledge base can prove to be very useful since it will be more up to date than the 
documentation shipped with the installation kits. Each recorded problem is organized with a one-line statement about 
the problem to help you find it quickly within the list. If you do not find the problem and a resolution or you think you 
found a problem similar to one in the knowledge base database and need additional help, then continue on to the next 
step.

Step 5- Gather information and send to support@openspirit.com

If you've reached this step, it is possible that you have found a new problem or you can't find a problem and solution 

Y
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in the Release Notes, Troubleshooting Guide, or OpenSpirit knowledge base. If this is the case, don’t worry; we don't 
want you to spend too much time searching and it may be that you have found a new problem that we need to know 
about right away.

The following paragraphs describe the information that should accompany a problem reported via email.

While running OpenSpirit there are several server log files where information is recorded. In most cases we can 
successfully diagnose the problem and provide a solution by reviewing those log files. There isn't any sensitive 
information in the log files, just information related to how OpenSpirit was installed and configured and what exactly 
was going on when the problem was encountered. We need to review those log files before we can properly start 
diagnosing the problem. The sooner we get these files the sooner we can solve your problem and get you back up and 
running.

All OpenSpirit Shared Server log files are stored in the $OSP_HOME/logs/SharedServices directory where 
you installed OpenSpirit. All OpenSpirit user logs are stored in the $HOME/OpenSpirit/logs directory. You can 
tar or zip up those entire directories and e-mail them to us. If the tar file is larger than one megabyte, contact us and 
we will give you an ftp site to use.

We also need any output that may have been displayed on an xterm or in a message box when you experienced the 
problem. You can cut and paste this information and add it to the E-mail you send us. But most likely we will be able 
to see what is happening from the log files.

Receiving these files will help us communicate with you better about your problem. In most cases we can tell enough 
about what is going on to diagnose your problem and provide a resolution. Not having this information available to 
the support engineer will most likely delay the resolution of your problem. Please retrieve these files and send them to 
us prior to logging the support call. Once the dialog with OpenSpirit starts we will be able to effectively diagnose your 
problem. At times we may ask you to try certain things and then report back to us for the problems that are more 
obscure.

Step 6- That's it!

You should never reach this section! In the previous steps you should have received help from a support engineer to 
resolve your problem in a timely manner or at least gather enough information so the problem can be fixed in a future 
release. If this isn't the case then you have probably come to this section because of an inadequate resolution to your 
problem. In this event we want to make sure that you receive immediate attention. You can do this by sending e-mail 
to support@openspirit.com with a subject of URGENT ATTENTION REQUESTED! If, for any reason, you need the 
troubleshooting process expedited, please call our support line at 281-295-1400. We will do everything humanly 
possible to contact you as soon as possible and get to the bottom of your problem - your satisfaction is our goal!
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Troubleshooting Guide

This guide will help you solve problems that you may run into while using OpenSpirit. It is intended 
to provide the necessary information as the first line of support prior to contacting OpenSpirit. If 
you can't solve your problem with the information found in this guide, and you have already 
reviewed the Release Notes, then proceed to the next step in the Support section.

This document is composed of some of the most common problems that you may encounter while 
using OpenSpirit. It will guide you through some of the items our support engineers would look at 
first. We do not expect you to spend much time troubleshooting on your own, but very often we find 
that problems are caused by a few common things. You can quickly look into these areas and 
possibly solve the problem on your own. However, if you still need assistance, please don't hesitate 
to contact us.

Troubleshooting is logically separated into Runtime problems and Installation or Configuration 
problems. If you have had a working installation and are running into problems while using 
OpenSpirit, skip the Installation Troubleshooting section. However, note that some runtime 
problems could actually be caused indirectly by an incorrect installation. Such situations should 
become obvious as you begin to review the information below.

Runtime Troubleshooting

Check the logs 

Most OpenSpirit software puts information into log files. The log files for the shared servers are in 
$OSP_HOME/logs/SharedServers. The log files for user related servers are in $HOME/
OpenSpirit/logs. 

Normally the problem you are experiencing will be recorded in the newest file in one or both of 
these directories. For example, type ls -alrt in both of these directories and then look at the end of 
the newest file in each of these directories. If you see an error in one of these log files, hopefully it 
will help you to understand what is going wrong. If you find errors that you cannot explain, turn to 
the Support section for further support.

Installation Troubleshooting

If you are experiencing problems starting the installer you can turn on a debug flag. You can do this 
by setting it as an environment variable prior to starting the installer, which will help identify what 
is wrong. To set the flag type: setenv LAX_DEBUG true. 
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During installation, all fields are validated to help make sure you end up with a proper installation. 
If you are having difficulty answering any of the questions, please refer to the following section: 
Installation on page 125 and the help dialogs in each screen. If this does not help, please send e-mail 
to support@openspirit.com.
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